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一般安全摘要

一般安全摘要

請檢視下列的安全警告以避免傷害，並預防對此產品或任何相關產品的損害。

為避免潛在的危險，請僅依照指示使用此產品。

只有合格的維修人員方可操作維修程序。

使用此產品時，您可能需要存取較大型系統的其他部分。請閱讀其他元件手冊的安全章節，了解操作
系統的相關警告與注意事項。

避免火災或人身傷害

使用適當的電源線。 請只使用本產品所指定以及該國使用認可的電源線。

正確地連接與中斷連接。 當探棒或測試線與電壓來源連接時，請勿連接它們或中斷與它們的連接。

將產品接地。 本產品是透過電源線的接地導線與地面連接。為了避免電擊，接地導線必須連接到地
面。在與產品的輸入與輸出端子連接之前，請確定產品已正確地接地。

觀察所有的端子功率。 為了避免火災或是電擊的危險，請注意產品上的功率及標記。在與產品連
接之前，請先參閱產品手冊以便進一步瞭解有關功率的資訊。

這些輸入並非用於主要或類別 II、III 或 IV 電路的連接。

只將探棒參考導線連接到地面。

電源中斷連接。 電源線已中斷產品與電源的連接。請勿阻礙電源線，使用者必須可以隨時存取電源
線。

請勿在蓋子未蓋上之前即進行操作。 如果蓋子或是面板被取下，請勿操作本產品。

懷疑有故障時，請勿操作。 若您懷疑此產品已遭損壞，請讓合格的維修人員進行檢查。

避免電路外露。 當有電流通過時，請勿碰觸外露的連接器及元件。

請勿在潮濕的狀態下操作。

請勿在易燃易爆的空氣中操作。

請維持產品表面的清潔與乾燥。

保持空氣的流通。 請參考手冊的安裝說明以瞭解有關如何安裝產品使其具有良好通風的詳細資訊。
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一般安全摘要

此手冊中的規定

本手冊可能會出現下列規定：

警告。 警告聲明中指明了可能導致受傷或喪命的情況或操作。

小心。 小心聲明中指明了可導致損壞此產品或其他物品的情況或操作。

產品上的符號和規定。

這些規定可能會出現在產品上：

「危險」表示當您看到此標誌時可能會有立即受傷的危險。

「警告」表示當您看到此標誌時並不會有立即受傷的危險。

「小心」表示可能損及財產 (包括本產品) 的危險。

下列符號可能會出現在產品上：
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相容資訊

相容資訊

本節將列出儀器所依循的 EMC (電磁相容)、安全和環境標準。

符合 EMC 的規範

EC 符合性聲明 - EMC

電磁相容性滿足 Directive 2004/108/EC 的內容。 如歐盟官方期刊中所列出的證明符合下列規格：

EN 61326-1:2006、EN 61326-2-1:2006: 測量、控制和實驗室使用之電子設備必須遵守的 EMC 需求。
1 2 3

CISPR 11:2003。輻射和傳導放射，群組 1，A 等級。

IEC 61000-4-2:2001。靜電釋放耐受性

IEC 61000-4-3:2002。RF 電磁場耐受性 4

IEC 61000-4-4:2004。電磁快速暫態/脈衝耐受性

IEC 61000-4-5:2001。電源線突增耐受性

IEC 61000-4-6:2003。傳導 RF 耐受性 4

IEC 61000-4-11:2004。電壓驟降和干擾耐受性 5

EN 61000-3-2:2006: AC 電源線諧波發射

EN 61000-3-3:1995: 電壓變化、波動和閃爍

歐洲聯絡人:
Tektronix UK, Ltd.
Western Peninsula
Western Road
Bracknell, RG12 1RF
英國

1 本產品僅適用於非住宅區。 用於住宅區可能會造成電磁干擾。

2 當本儀器連接測試物品時，發射層級可能會超過這項標準要求。

3 在進行內部連接時，您必須使用低 EMI 遮罩纜線，例如以下的 Tektronix 零件編號或同等級產品： 012-0991-01、
012-0991-02 或 012-0991-03 GPIB 纜線；012-1213-00 (或 CA 零件編號 0294-9) RS-232 纜線；012-1214–00 Centronics 纜
線；LCOM 零件編號 CTL3VGAMM-5 VGA 纜線。 使用 Ref Out 接頭適用的 012-0482-00 纜線。

4 當示波器位於連續呈現的電磁現象時適用的性能準則： 當示波器位於暫態的電磁環境時適用的 10 mV/div 到
1 V/div:≤0.4 格波形位移，或是峰對峰雜訊增加≤0.8 格時適用的性能準則。 允許暫時、可自行恢復的效能衰減或
遺失，但不允許實際作業狀態改變或遺失已儲存資料。

5 性能準則 C 適用於 70%/25 週期電壓驟降以及 0%/250 週期電壓干擾測試等級 (IEC 61000-4-11)。 如果儀器的電源在電
壓驟降或干擾時關閉，重新開機的時間將需要 10 秒以上。
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相容資訊

澳洲 / 紐西蘭符合性聲明 - EMC

本儀器符合 Radiocommunications Act 中制定 EMC 條款的下列標準：

CISPR 11:2003。輻射和傳導放射，群組 1，A 等級，並符合 EN 61326-1:2006 和 EN 61326-2-1:2006。
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相容資訊

安全相容性

EC 符合性聲明 - 低電壓

如歐盟官方期刊中所列出的證明符合下列規格：

低電壓 Directive 2006/95/EC。

EN 61010-1: 2001。測量控制和實驗室使用之電子設備必須遵守的安全需求。

美國國家認可測試實驗室清單

UL 61010-1:2004, 2nd 版本。 電子測量與測試設備標準。

加拿大檢定證明

CAN/CSA-C22.2 No. 61010-1:2004。測量、控制和實驗室使用的電子設備必須遵守的安全需求。 第
一部分。

其他相容性

IEC 61010-1: 2001。測量、控制和實驗室使用之電子設備必須遵守的安全需求。

設備類型

測試和測定設備。

安全等級

等級 1 – 接地性產品。

污染等級說明

本產品周圍和內部環境可能需要進行污染測定評估程序。 通常產品內部環境會視為相同於其外部環
境。 本產品只適用於已評估的環境。

污染等級 1。 沒有產生污染，或是只允許乾燥、非傳導式污染物。 這項類別的產品通常會加以密
封、氣密封存或是放置在無塵室中。

污染等級 2。通常只允許發生乾燥、非傳導式污染物。 必須預防因凝結所發生的暫時傳導性。 這
種場所通常是辦公室∕居家環境。 暫時性凝結只會在產品不使用時發生。

污染等級 3。傳導式污染，或是由於凝結導致乾燥、非傳導式污染成為傳導式污染。 這是指沒有
控制溫度或溼度的遮蔽場所。 該區域可避免陽光直曬、雨水或是直接風吹。

污染等級 4。指透過傳導性灰塵、雨水或雪產生永久傳導性的污染。 典型戶外場所。

污染等級

污染等級 2 (依據 IEC 61010-1 定義)。 注意： 評估僅限於室內。
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相容資訊

安裝 (過電壓) 類別說明

本產品的端子可能提供不同的安裝 (過電壓) 類別設計。 這些安裝類別分別是：

測定類別 IV：測定低電壓安裝來源。

測定類別 III：在建構安裝時執行測定。

測定類別 II：測定直接連接低電壓安裝的電路。

測定類別 I：測定未直接連接 MAINS 的電路。

過電壓類別

主要： 過電壓類別 II

測量輸入端： 過電壓類別 I

(依照 IEC 61010-1 所定義)
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相容資訊

環境注意事項
本節提供此產品對環境所造成的影響之相關資訊。

產品報廢處理

回收儀器或元件時，請參閱下列指引：

設備回收: 本設備的生產作業需要自然資源之回收與利用。 若在產品報廢時未正確處理，此設備可
能含有對環境或人類健康有害的物質。 為了避免此類物質釋放到環境，並減少使用自然資源，建議您
透過適當系統回收此產品，以確保大部分的材料均適當地回收或再利用。

依照歐盟廢棄電子電器設備 (WEEE) 和電池指令要點Directives 2002/96/EC 和 2006/66/EC，此
符號表示此產品遵守歐盟要求。如需回收選項的詳細資訊，請參閱Tektronix 網站 (www.tek-
tronix.com) 支援∕服務區。

水銀標示: 本產品使用含水銀的 LCD 背光燈。 因此廢棄處理必須符合環保規範。 請聯絡您當地的權
責機關。若您位於美國，請參閱 E-cycling Central 網頁 (www.eiae.org)，以取得棄置或回收資訊。

高氯酸鹽材料: 此產品包含一或多種 CR 鋰電池類型。 根據加州法律，CR 鋰電池被歸類為高氯酸鹽
材料，必須採取特殊處理。 請參閱 www.dtsc.ca.gov/hazardouswaste/perchlorate 取得其他資訊。

危險物質之限用

本產品被分類為「監視器與控制器」設備，而不在 2002/95/EC RoHS Directive 管轄範圍內。
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前言

前言

本手冊說明 DPO7000 系列、DSA70000/B 系列和 DPO70000/B 系列儀器的安裝和操作方式。 本手冊將介
紹基本操作及概念。 如需更多詳細資訊，請參閱儀器的線上說明。 本手冊支援以下儀器：

DPO72004/B 和 DSA72004/B

DPO71604/B 和 DSA71604/B

DPO71254/B 和 DSA71254/B

DPO70804/B 和 DSA70804/B

DPO70604/B 和 DSA70604/B

DPO70404/B 和 DSA70404/B

DPO7354

DPO7254

DPO7104

DPO7054

主要功能
DPO7000、DSA70000/B 和 DPO70000/B 系列儀器有助您確認、偵錯和記述特徵的電子圖。 主要功能包
括：

所有波道為 20 GHz 頻寬與 50 GS/s 即時取樣率 (DPO72004/B 和 DSA72004/B)

所有波道為 16 GHz 頻寬與 50 GS/s 即時取樣率 (DPO71604/B 和 DSA71604/B)

所有波道為 12.5 GHz 頻寬與 50 GS/s 即時取樣率 (DPO71254/B 和 DSA71254/B)

所有波道為 8 GHz 頻寬與 25 GS/s 即時取樣率 (DPO70804/B 和 DSA70804/B)

所有波道為 6 GHz 頻寬與 25 GS/s 即時取樣率 (DPO70604/B 和 DSA70604/B)

所有波道為 4 GHz 頻寬與 25 GS/s 即時取樣率 (DPO70404/B 和 DSA70404/B)

所有波道為 3.5 GHz 頻寬與 10 GS/s 即時 取樣率、波道 1 為 40 GS/s (DPO7354)

所有波道為 2.5 GHz 頻寬與 10 GS/s 即時取樣率、波道 1 為 40 GS/s (DPO7254)

所有波道為 1 GHz 頻寬與 5 GS/s (10 GS/s 選配) 即時取樣率、波道 1 為 20 GS/s (40 GS/s 選配)
(DPO7104)

所有波道為 500 MHz 頻寬與 2.5 GS/s (5 GS/s 選配) 即時取樣率、波道 1 為 10 GS/s (20 GS/s 選配)
(DPO7054)

當「加強型頻寬」功能啟用時，便可套用擴充頻寬和拉平帶通頻率的「數位訊號處理 (DSP)」濾波
功能。「加強型頻寬」在波道達到最大取樣率時，經由已啟用的波道提供配比響應。為讓雜訊比
例下的訊號達到最佳化，可將每次增加 1 GHz 頻寛的最大頻寛限制在 500 MHz。加強型頻寬延伸至
某些高效能探棒和頭的探棒頭。

視不同型號和選項而定，記錄長度最多可達 5 億個取樣。

最高可達 1.0% DC 垂直增益精確度； 依不同型號而有差異
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前言

4 個輸入波道 (不用高解析度模式時，每個波道有 8 位元解析度)，輔助觸發輸入和輸出

取樣、包封、峰值檢測、高解析度、WfmDB (Waveform Database)、平均值和 FastAcq 等擷取模式

附擴充的 GPIB 指令程式和訊息介面的完整可程式化能力

可供 A 和 B 觸發事件選取的觸發方式，包括邊緣、邏輯、脈波 (可為邏輯限定) 等。當觸發源通往
∕穿出已定義視窗時，便觸發視窗觸發模式。觸發可為邏輯限定的觸發。當邏輯輸入改變設定內
部的狀態時，便觸發設定和保持觸發模式；並保持相對時序的時間。觸發抖動將小於 1 ps RMS (典
型)；依不同型號而有差異。通常您可觸發寬度小於 200 ps 的突波或脈波。部份型號或選項可提供
低速序列觸發、串列樣式觸發和樣式鎖定觸發等功能。可選擇的觸發位置更正，可以更精確的放
置觸發並且滅少抖動。

功能強大的內建測量能力，包括有 長條圖、自動測量、眼狀圖測量和測量 統計值。

採用算術方式來組合波形，建立支援資料分析工作的波形。在數學方程式中使用任意濾波器。使
用頻譜分析來分析頻域中的波形。

支援波型資料漸層的大型 12.1 英吋 (307.3 毫米) 高解析度 XGA 彩色螢幕，以便顯示取樣密度。可
在水平和垂直刻度分別顯示 10 個格點。

最多可以同時檢視並比較 4 個縮放區域的 MultiView Zoom 功能。可一次鎖定並手動∕自動捲動最
多 4 個縮放區域。可控制縮放視窗內的波形顯示。

自動事件搜尋和使用者標記，可自動尋找並參考波形上的特定點。

使用 DDR Memory Technology Analysis (DDR 記憶體技術分析) 選項的自動 DDR 分析

可自訂的 MyScope 控制視窗

可從每格的時間，分別控制取樣率和記錄長度。

直觀的圖形使用者介面 (UI)，其中內建了可顯示於螢幕的線上說明

內部可移除式儲存磁碟

一系列的探棒解決方案

說明文件
請參閱下表，了解可用於本產品的各種資訊及其位置。

相關主題 說明文件

安裝和操作 (概要) 快速入門使用者手冊。提供一般操作資訊。

深入的操作和使用者介面說明 線上說明。提供使用儀器功能的詳細指示說明。從Help (說明)
按鈕存取線上說明或 Help (說明) 功能表，取得螢幕所示控制
項和元件的相關資訊。 ( 請參閱頁19，存取線上說明)

程式編寫指令 程式編寫指南 (收錄在產品軟體 DVD)。 包括 GPIB 指令的語
法。

服務資訊 維修手冊 (位於產品軟體 DVD 和文件瀏覽器)。

分析和連接工具 開始使用 OpenChoice 解決方案手冊。提供儀器上各種連接和
分析工具的相關資訊。
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本手冊使用慣例
本手冊使用以下圖示。

順序步驟 前面板電源 連接電源 網路 PS2 SVGA USB
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安裝儀器

安裝儀器

請拆封儀器，並檢查您已收到所有列於「標準配件」的項目。線上說明會列出建議的配件、探棒、儀
器選配項目和升級。若需最新資訊，請前往 Tektronix 網站 (www.tektronix.com)。

標準配件

配件 Tektronix 零件號碼

DPO7000、DSA70000/B 和 DPO70000/B 數位螢光示波器快速入門
使用者手冊

071-2597-xx

DPO7000、DSA70000/B 和 DPO70000/B 產品軟體 DVD 020-2693-xx

選配的應用軟體 DVD 和說明文件套件 020-2700-xx

線上說明 (產品軟體的一部份) —

性能驗證 (收錄於產品軟體 DVD 的 PDF 檔案) —

程式編寫線上指南 (收錄於產品軟體 DVD 的檔案) —

NIST、Z540-1 和 ISO9000 校準證書 —

4 根 10X 被動探棒，500 MHz 型號 (僅 DPO7054 適用) P6139A

1 個 TekConnect 轉接器 (僅 ≥4 GHz 的型號適用) TCA-BNC

4 個 TekConnect 轉接器 (僅 ≥4 GHz 的型號適用) TCA-292MM

鍵盤 (僅 ≥4 GHz 的型號適用) 119-7083-xx

滑鼠 (光學) 119-7054-xx

前外蓋 200-4963-xx

配件包 <4 GHz 的型號：016-1966-xx

≥4 GHz 的型號：016-1441-xx

Nero OEM 軟體 CD 063-3781-xx

下列各項之一： <4 GHz 的型號 ≥4 GHz 的型號

北美 (選項 A0) 161-0104-00 161-0213-00

歐洲通用 (選項 A1) 161-0104-06 161-0209-00

英國 (選項 A2) 161-0104-07 161-0210-00

澳洲 (選項 A3) 161-0104-05 161-0211-01

瑞士 (選項 A5) 161-0167-00 161-0212-00

日本 (選項 A6) 161-A005-00 161-0213-00

中國 (選項 A10) 161-0306-00 161-0320-00

印度 (選項 A11) 161-0324-00 161-0325-00

電源線

無電源線或交流轉接器 (選項 A99) — —
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安裝儀器

操作需求

1. 將儀器放在 儀器專用推車或測試
台，觀察其空間需求和尺寸：

<4 GHz 的型號 ≥4 GHz 的型號

頂部： 0 英吋 (0 毫米) 0 英吋 (0 毫米)

左側和右側： 3 英吋 (76 毫米) 3 英吋 (76 毫米)

底部： 0 英吋 (0 毫米)支腳站立，支
架朝下

0 英吋 (0 毫米)支腳站立，支
架朝下

背面： 距離後支腳 0 英吋 (0 毫米) 距離後支腳 0 英吋 (0 毫米)

2. 寬度： 17.96 英吋 (456 毫米) 17.75 英吋 (451 毫米)

3. 高度： 10.9 英吋 (277 毫米) 11.48 英吋 (292 毫米)

4. 請在操作儀器之前先 檢查環境溫
度：

5 °C 到 +45 °C (+41 °F 到
+113 °F)。

5 °C 到 +45 °C (+41 °F 到
+113 °F)。

5. 確認操作溼度： 在最高濕球溫度為 +29 °C
(+84 °F)或低於+45 °C (+113 °F)
的非露點溫度下 相對溼度須
為 8% 到 80%

在 +45 °C (+113 °F) 時，最大
限制會遞減至 30% 相對溼度

最高溫度至 +32 °C (+90 °F) 的
相對溼度須為 8% 到 80%

5% 到 45% 相對溼度，溫度
超過 +32 °C (+90 °F)、最高溫
達 +45 °C (+113 °F)，非露點溫
度，而且必須符合最高濕球
溫度 +29.4 °C (+85 °F) 範圍 (在
+45 °C (+113 °F) 相對溼度會減
額到 32%)

6. 確認操作高度： <4 GHz 的型號：3,000 公尺
(9,843 英呎)

≥4 GHz 的型號： 3,000 公尺
(9,843 英呎)，高度超過 1500
公尺 (4921.25 英呎) 時，每升
高 300 公尺 (984.25 英呎)，最
大操作溫度會降低 1 °C 。

7. 最大輸入電壓，<4 GHz 的型號：

50 Ω

1 MΩ

5 Vrm，峰值 ≤ ±24 V。

150 V，超過 200 KHz 時，以 20 dB 間隔衰減到 9 Vrms。 介於中
央導線到接地的最大 BNC 輸入電壓是 400 V 峰值。 包括直流
之任意波形的 RMS 電壓限制為 <150 V。 峰值超過 150 V 的脈
衝，其最大脈波寬度是 50μs。範例：從 0至 400 V峰值時，
長方形波形，其工作係數是 14%。 最大暫態耐受電壓是 ± 800
V 峰值。
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安裝儀器

最大輸入電壓，≥4 GHz 的型號：

50 Ω <1 Vrms 適用於 <1V/FS 設定，< 5.5 Vrms 適用於 ≥1 V/FS 設定。

小心。 為了確保適當冷卻效果，請保持儀器底部和兩側沒有任何阻礙物。
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安裝儀器

預防 ESD

小心。 直接的靜電釋放會損壞儀器輸出。 若要瞭解如何避免該損壞，請閱讀以下資訊。

在處理任何電器設備時，您必須注意靜電釋放 (ESD) 相關問題。 雖然儀器本身的設計具有強大的 ESD
防護，但大量的靜電直接進入訊號輸出時仍有可能造成儀器的損壞。 若要避免儀器的損壞，請使用以
下的技巧來預防靜電釋放到儀器中。

1. 當連接和拔除 TekConnect 轉接器
的纜線時，請配戴接地的抗靜電
腕帶，以釋放您體內的靜電電壓。
儀器已基於此目的而提供前面板
連接。

2. 測試台上未連接的纜線會產生大
量的靜電。 在將纜線連接到儀器
之前，將纜線的中央導線快速接
地，或將 50 Ω終端連接到一端，
以將纜線連接到測試中的儀器或裝
置之前釋放所有纜線中的靜電。
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安裝儀器

開啟儀器電源

電源供應需求

來源電壓與頻率 電源消耗

<4 GHz 的型號：100–240 VRMS ±10%、47–63 Hz
或是 115 VRMS ±10%、400 Hz

最大值 550 瓦數

≥4 GHz 的型號：100 - 240 VRMS ±10%、50 - 60 Hz
，或 115 VRMS ±10%、400 Hz。CAT II

≦ 1100 VA
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安裝儀器

<4 GHz 的型號

≥4 GHz 的型號：
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安裝儀器

關閉儀器電源

中斷電源

<4 GHz 的型號

≥4 GHz 的型號
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安裝儀器

連接到網路

您可以將儀器連接到網路，進行列
印、檔案共享、網路存取和其他功
能。請先詢問網路管理員，再使用標
準Windows 公用程式來設定儀器的網
路連線。

注意。 若要透過網路進行遠端操作，請切換啟動 Display > Display Remote (顯示 > 遠端顯示)。VNC 或
pcAnywhere 必須安裝在這台儀器和 此遠端 PC 上。當 Display Remote (遠端顯示器) 啟用時，顯示器會進
行更新，因此控制視窗 存取和功能表項目速度會變慢。
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安裝儀器

新增第二台顯示器
您可以一邊操作儀器，一邊在外部顯示器上使用 Windows 和已安裝的應用程式。請依照下列程序執
行，設定雙顯示器組態。

<4 GHz 的型號

1. 關閉電源。

2. 連接第二台顯示器。

3. 連接鍵盤。

4. 連接滑鼠。

5. 開啟儀器電源。

6. 開啟顯示器電源。

<4 GHz 的型號
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安裝儀器

≥4 GHz 的型號

1. 關閉電源。

2. 連接第二台顯示器。

3. 連接鍵盤。

4. 連接滑鼠。

5. 開啟儀器電源。

6. 開啟顯示器電源。

≥4 GHz 的型號
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安裝儀器

7. 在 Windows 桌面上按右鍵，接著
選取「內容」。

8. 選取「設定值」。按一下顯示灰
色的外部顯示器 ( 2 )，將其拖曳到
顯示器 1 的左邊。

9. 在提示啟用新顯示器的訊息方塊
中選取「是」。

10. 按一下「套用」。

11. 按一下「是」重新啟動儀器。
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安裝儀器

建立作業系統復原光碟
儀器並未隨附作業系統復原光碟。使用下列程序建立一份必要時可讓您復原作業系統的光碟。

注意。 此程序可建立一份適用於 Microsoft Windows 作業系統的復原光碟。復原作業系統後，使用 產
品軟體 CD重新安裝儀器應用程式軟體。依照產品軟體 CD提供的指示，重新安裝儀器應用程式軟體。

建立復原光碟

必要條件: 空白的 CD-R 光碟片 (一支備份檔案使用一片光碟)。

若要建立一份復原光碟：

1. 將空白的 CD-R 光碟片插入儀器的 DVD 磁碟機。

2. 按一下開始 > 所有程式 > Nero 7 Essentials > 資料 > Nero Express Essentials。

3. 按一下 Image (影像)、Project (計畫)、Copy (複製)。

4. 按一下 Disk Image (磁碟影像) 或 Saved Project (儲存的計畫)。

5. 巡覽到 C:\backup。

6. 選取 file backup1 (檔案備份1) 並按一下 Open (開啟)。

7. 按一下 Verify data on disk after burning (燒錄後驗證磁碟上的資料) 核取方塊以啟用此功能。

8. 按一下 Burn (燒錄) 按鈕。應用程式會將備份檔案寫入 CD-R，接著驗證 CD 上的資料是否符合來源
檔案。

9. 當應用程式報告成功完成 CD 寫入程序時，移除 CD-R 並隨之加以標示 (包含備份檔案名稱、儀器
名稱、儀器序號以及日期)。

10. 剩下的備份檔案每支都重複 1 到 9 的步驟。

11. 若要備份，請將位於 C:\backup 目錄中的磁碟影像檔案 (*.iso) 複製到網路位置、個別硬碟或是磁碟
機。

12. 以您公司政策定義的方式儲存備份 CD。

注意。 您僅可在建立作業系統復原光碟的儀器上使用該光碟。
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了解儀器

了解儀器

前面板

1. DVD/CD-RW 光碟機

2. 前面板控制項

3. USB 埠

4. 接地端子

5. 復原的資料輸出

6. 復原的時脈輸出

7. 探棒補償輸出

8. 探棒校準輸出

9. 波道 1–4 輸入

10. 輔助觸發輸入

11. 快速邊緣輸出

12. 直流探棒校正輸出 <4 GHz 的型號

≥4 GHz 的型號

DPO7000 系列和 DPO/DSA70000/B 系列快速入門使用者手冊 13



了解儀器

側面板和後面板

1. USB 埠

2. 連接顯示器左右比較顯示的視頻
埠

注意。 有些儀器可能有其他音效接
頭。

3. 連接麥克風的麥克風接頭

4. 喇叭的 Line Out 接頭

5. 連接顯示器的XGA輸出視訊埠(僅
適用於示波器)

6. 印表機連線

7. Line In 接頭

8. 連接網路的 RJ-45 LAN 接頭

9. 並列平行埠

10. COM 1 序列埠

11. 滑鼠專用 PS-2 接頭

12. 鍵盤專用 PS-2 接頭

13. 後喇叭輸出

14. 側邊喇叭輸出

15. CTR 低音喇叭

16. 備用 TekLink 接頭

17. 卸除式硬碟

18. 連接控制器的 GPIB 界面

19. 輔助輸出

20. 波道 3 輸出

21. 外部參考輸入

<4 GHz 的型號
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了解儀器

1. 卸除式硬碟

2. 滑鼠專用 PS-2 接頭

3. USB 埠

4. 並列平行埠

5. 連接網路的 RJ-45 LAN 接頭

6. 連接顯示器的視訊埠

7. TekLink 接頭

8. 連接控制器的 GPIB 界面

注意。 有些儀器可能有其他音效接
頭。

9. Line In 接頭

10. 喇叭的 Line Out 接頭

11. 連接麥克風的麥克風接頭

12. 連接顯示器左右比較顯示的視頻
埠

13. COM 1 序列埠

14. 鍵盤專用 PS-2 接頭

15. CTR 低音喇叭

16. 側邊喇叭輸出

17. 後喇叭輸出

18. 輔助輸出

19. 參考輸出

20. 外部參考輸入

≥4 GHz 的型號
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了解儀器

介面和顯示
功能表列模式可用來存取控制本儀器所有功能和性能的指令。工具列模式可存取最常用的功能。

1. Menu Bar (功能表列)： 存取資料
輸入∕輸出 (I/O)、列印、線上說
明和儀器功能

2. Buttons/Menu (按鈕∕功能表)： 按
一下便可切換工具列模式和功能
表列模式，以及自訂工具列

3. Multipurpose Knob Readouts (多用途
旋鈕讀值)：調整及顯示多用途旋
鈕控制的參數

4. Display (顯示)： 呈現顯示中的波
形、參考波形、算術運算波形，
以及游標

5. Waveform Handle (波形拖曳點)：按
一下並拖曳，便可變更波形的垂
直位置。按一下拖曳點，便可透過
多用途旋鈕來變更位置和刻度。

6. Controls Status (控制項狀態)：對應
至垂直改變、刻度、偏移和參數
的快速參考

7. Readouts (讀值)： 顯示這個區域中
的游標和測量讀值。您可從功能
表列或工具列選取測量值。如果
出現控制視窗，表示某些讀值組
合會移到方格圖區域。

16 DPO7000 系列和 DPO/DSA70000/B 系列快速入門使用者手冊



了解儀器

警告。 如果出現垂直剪裁，探棒頭
則具有危險的電壓， 但讀數格只會

顯示低電壓。如果 出現垂直剪裁
的情況，儀器讀數格則會出現符號。
發生訊號垂直裁剪的自動振幅相關測
量值，所產生的結果將不精確。若儲
存或匯出讓其他程式使用的波形被裁
剪，也會導致不精確的振幅值。如果
是裁剪算術運算波形，則算術運算波
形的振幅測量值並不會受到 影響。

8. Status (狀態)： 顯示擷取狀態、模
式和擷取數目；觸發狀態、日期
和時間；以及對應至記錄長度和
水平參數的快速參考

1. Buttons/Menu (按鈕∕功能表)： 按
一下便可切換工具列和功能表列，
以及自訂工具列

2. 拖曳游標，便可測量螢幕上的波
形

3. 拖曳位置圖示，便可重新定位波
形

4. 請按一下圖示以指定波形垂直位
置和刻度的多用途旋鈕

5. 將滑鼠游標拉過波形區域，便可
建立特定矩形來縮放、啟用∕停
用長條圖，及範圍量測

6. 拖曳圖示，便可變更觸發位準
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了解儀器

控制面板

1. 按下此按鈕，便可自動依選取波
道來設定垂直、水平和觸發控制
項。

2. 按下此按鈕，便可恢復到預設值。

3. 按下此按鈕，便可直接列印或儲
存螢幕捕捉。

4. 按下此按鈕，便可啟動 MultiView
Zoom，並新增擴大方格圖到畫面
上。

5. 調整水平刻度、位置、延遲，以
及設定所有波形的記錄長度 (解析
度)。

6. 使用此按鈕來啟動和停止擷取、
啟動單一擷取程序、清除資料，
或啟動快擷取。

7. 使用此按鈕來設定觸發參數。按
下 Advanced (進階) 可顯示其他的
觸發功能。Arm (作用中)、Ready (
就緒) 和 Trig’d (已觸發) 燈號表
示擷取狀態。

8. 旋轉此旋鈕可調整波形強度。

9. 旋轉此旋鈕可調整從螢幕介面選
取的參數。按下此按鈕可切換一
般調整和微調。

10. 按下此按鈕可開啟和關閉游標。

11. 用於搜尋和標記波形。

12. 按下此按鈕可開啟和關閉觸控式
螢幕。

13. 開啟和關閉波道顯示。調整垂直
刻度、位置，或是偏移波形。切
換位置和偏移。
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了解儀器

存取線上說明
線上說明將深入提供本儀器所有功能的詳細資訊。

如果要從作用中視窗存取即時線上說
明，請選取說明>視窗上顯示說明...，
或是按下 F1。

1. 如果要存取說明系統中的任何主
題，請選取說明> 內容和索引...。

2. 使用「內容」、「索引」、「搜
尋」或「我的最愛」等索引標籤
來選取主題，然後按一下顯示。

如果要瀏覽說明系統，您可以：

按下說明視窗的按鈕，在「概要」
和特定主題之間瀏覽。

按一下說明視窗中的最小化按鈕
可將說明最小化，以便您操作儀
器。

同時按下Alt 和 Tab 可再查看上一
次的說明主題。
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了解儀器

存取功能表和控制視窗
您可以使用下列技巧來存取功能表和控制視窗：

按一下功能表，接著選取一個指
令。

在方格圖任何位置或在物件上按
滑鼠右鍵，便可使用捷徑功能表。
捷徑功能表可以即時線上顯示，
而且會依滑鼠右鍵按下的不同區
域位置或物件提供不同選項。右
圖舉出一些範例。

使用工具列模式時，按一下按鈕
可快速存取設定控制視窗。 (請參
閱頁16)
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檢查儀器

檢查儀器

使用下列程序來驗證儀器的功能。

驗證內部診斷通過

1. 開啟儀器電源。

2. 選取Instrument Diagnostics...(儀器診
斷...)。
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檢查儀器

3. 按一下 Run (執行)。測試結果會出
現在診斷控制視窗。

4. 請驗證所有測試皆已通過。如果
發生診斷失敗情形，請連絡您當
地的 Tektronix 服務人員。
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擷取

擷取

本節將介紹使用擷取系統的概念和程序。

訊號路徑補償
如果自上次訊號路徑補償至今溫差超過 5 °C (9 °F)，請使用這項程序。每週執行一次訊號路徑補償。若
未定期執行這項程序，可能會導致儀器無法達到保證的效能等級。

1. 先決條件：啟動儀器電源達 20 分
鐘，且所有輸入訊號已移除。

2. 選取Instrument Calibration (儀器校
準)。
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擷取

3. 當狀態變成 Temp (溫度) 時，請按
一下Calibrate (校準)以啟動校準。
校準程序可能需要 10到 15分鐘。

4. 如果儀器沒有通過，請重新校準
儀器，或是交由合格服務人員維
修。

注意。 若要在超過一個月未執行SPC
時顯示 SPC狀態圖示或顯示警告，請
按一下對應的選項按鈕。

5. 如果需要 SPC 的圖示為紅色時，
請執行訊號路徑補償。
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擷取

設定訊號輸入
使用前面板按鈕，可設定儀器進行訊號擷取。

1. 將探棒連接到輸入訊號源。

小心。 若要避免造成儀器的損壞，
在進行儀器的連接時請一律配戴接地
的抗靜電腕帶，並觀察輸入接頭的最
大輸入電壓功率。

<4 GHz 的型號

≥4 GHz 的型號

2. 按下前面板按鈕來開啟和關閉波
道，以便選取輸入波道。
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擷取

3. 按下 Autoset (自動設定)。

4. 使用前面板旋鈕調整垂直位置、
刻度和偏移。(按下旋鈕可切換位
置和偏移。)

5. 使用前面板旋鈕調整水平位置和
刻度。

水平位置會決定前置觸發和後置
觸發的取樣數目。

使用預設值設定

1. 如果要快速恢復到原廠預設值設
定，請按下 DEFAULT SETUP (預
設設定)。
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擷取

使用自動設定
使用 Autoset (自動設定) 功能，便可快速並自動依據輸入訊號特性來設定儀器 (擷取、水平、觸發和垂
直)。Autoset (自動設定) 可調整訊號，使波形靠近中間水平觸發來顯示 2 或 3 個週期。

1. 請接上探棒，再選擇輸入波道。
( 請參閱頁25，設定訊號輸入)

2. 按下 AUTOSET (自動設定)按鈕執
行自動設定功能。

3. 如果您要恢復成上次的Autoset (自
動設定) 值，請按一下 Undo ( 復
原)。不受 Autoset (自動設定) 影響
的參數仍會保留其設定。

快速秘訣

為了適當調整波形位置，您可能會用 Autoset (自動設定) 來改變垂直位置。Autoset (自動設定) 也可
調整垂直偏移。

顯示一個以上的波道時，如果您使用 Autoset (自動設定)，本儀器就會選取最小編號的波道執行水
平比例和觸發。您可以分別控制各個波道的垂直刻度。

如果在螢幕沒有顯示任何波道時使用 Autoset (自動設定)，儀器就會啟動波道 1 (Ch 1)，並設定波道
刻度。

按一下 X 便可關閉 Autoset Undo (復原自動設定) 控制視窗。Autoset Undo (復原自動設定) 關閉後，
您仍然可以從 Edit (編輯) 功能表選擇 Undo Last Autoset (復原上一次自動設定) 來恢復成上一次的自
動設定。

您可以在 Utilities (公用程式) 功能表變更 User Preferences (使用者偏好)，設定 Autoset Undo (復原自動
設定) 控制視窗不要自動開啟。
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擷取

探棒補償、校準和偏移校正
請參閱儀器線上說明執行下列程序，以最佳化測量精確度：

補償被動探棒

補償儀器訊號路徑

校準主動探棒

偏移校正輸入波道

擷取概念

擷取硬體

顯示訊號之前，訊號會先通過輸入波道，以設定刻度和完成數位化。每個波道都有專用的輸入放大器
和數位器。每個波道都會產生數位資料流，讓儀器從中擷取波形記錄。

取樣過程

擷取是指取樣類比訊號、將其轉換成
數位資料、組合成波形記錄，接著波
形記錄再儲存到擷取記憶體的過程。

即時取樣

使用即時取樣時，儀器會數位化所有
單一觸發事件擷取到的點。使用即時
取樣可以擷取單擊訊號或暫態訊號。

內插即時取樣

使用內插即時取樣時，儀器將數位
化所有單一觸發事件擷取到的點。如
果儀器無法透過最大即時取樣率擷取
建立完整波形的足夠取樣數，它就會
採取內插方式。使用內插即時取樣可
以擷取單擊訊號、暫態訊號或低速擷
取。
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等時取樣

本儀器會使用等時取樣，將取樣率
擴展超過其即時最大取樣率。只有當
Equivalent Time (等時) 已選取，而且
即時取樣之時基已設定成取樣率快到
無法建立波形記錄的情況下，您才能
使用等時取樣功能。

本儀器會多次擷取重複性波形，以便
取得完整波形記錄在建立時所需的取
樣密度。可想而知，等時取樣功能只
可用於重複性訊號。

波形記錄

本儀器將以下列參數來建立波形記
錄：

取樣間隔：取樣點之間的時間。

記錄長度：波形記錄構成時所需
要的取樣數量。

觸發點：波形記錄中的零時間參
考點。

水平位置：在關閉水平延遲時，
水平位置表示波形記錄百分比例
(介於 0% 到 99.9%)。觸發點和水
平參考在波形記錄中將顯示相同
時間。例如，當水平位置為 50%
時，觸發點就是位在波形記錄的
中間。如果有啟用水平延遲，從
觸發點到水平參考之間的時間就
是水平延遲時間。

內插法

當儀器沒有取得建立波形記錄所需之全部實際取樣時，儀器可以在擷取的取樣間採用內插法。線性內
插法會應用最適直線，計算出介於實際擷取取樣之間的記錄點。

Sin(x)/x 內插法會應用最佳曲線，計算出介於實際擷取數值之間的記錄點。Sin(x)/x 內插法為預設的內
插模式。因為它在準確呈現波形時所需的實際取樣點數比線性內插法少。
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擷取模式的運作方式

Sample (取樣)模式會保留從每個擷取
間隔的第一個取樣點。「取樣」是預
設模式。

Peak Detect (峰值檢)模式會使用兩個
連續擷取間隔所含全部樣本中最高和
最低者。這個模式只能用於即時、沒
有任何插入的取樣，而且可以用來捕
捉高頻率突波。

Hi Res (高解析度) 模式對所有擷取間
格計算其平均取樣值。「高解析度」
模式提供較高解析度、較窄頻寬的波
形。

Envelope (包封)模式會從眾多擷取中
找出最高和最低的記錄點。「包封」
模式會為每次擷取使用「峰值檢測」
模式。

Average (平均)模式會計算眾多擷取上
每個記錄點的平均值。「平均」模式
會為每個擷取使用「取樣」模式。請
使用平均模式來降低隨機雜訊。

Waveform Database (波形資料庫)模式
會在數次擷取後建立來源波形資料的
三維累積。除了振幅和時序資訊，這
個資料庫還會包括所擷取特定波形點
(時間和振幅) 的次數計數。
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改變擷取模式
請使用此程序來改變擷取模式。

1. 選取 Horiz/Acq > Acquisition Mode
( 水平/擷取＞擷取模式)。

2. 請執行下列一項動作來選取擷取
模式：

直接從功能表選取擷取模式。

按一下 Mode... (模式...)選取擷
取模式。

3. 使用Average (平均)或 Envelope (包
封) 擷取模式時，請按一下 # of
Wfms (波形數目) 控制項，然後以
多用途旋鈕設定波形數目。使用
WfmDB (波形資料庫) 模式時，請
按一下 Samples (取樣)控制項，然
後以多用途旋鈕設定取樣數目。

快速秘訣

按一下數字鍵盤圖示，便可設定波形或取樣的數目。
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開始和停止擷取
在選取要擷取的波道之後，請使用下列程序。

1. 請按下前面板的 RUN/STOP (運行
∕停止)按鈕，開始進行擷取。

2. 再按一次RUN/STOP (運行∕停止)
按鈕，便可停止擷取。

3. 如果要進行單一擷取，請按下
Single (單一)按鈕。

選取水平模式
您的儀器有三個水平模式。「自動」是預設模式。請選取最適合測試設定的水平模式。

若要設定水平模式，請選取Horiz/Acq
> Horizontal/Acquisition Setup (水平/擷
取 > 水平/擷取設定)，顯示水平控制
視窗。選擇下述模式之一。

在「自動」模式可以設定「刻度」和
「取樣率」。記錄長度是相依變數。
若變更刻度會讓記錄長度超出「記錄
長度限制」，取樣率會減少至下一個
可用設定。

取樣模式若為即時且取樣率到達即時
限制，便無法增加取樣率。
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若要設定「記錄長度限制」，請按
一下 Record Length Limit (記錄長度限
制)，並使用按鈕或鍵盤設定限制。
預設的最大限制取決於儀器型號和記
錄長度選項。

在「常態取樣率」模式可以設定「取
樣率「和「刻度」。預設取樣率可以
確保頻寬濾波器作業。記錄長度是相
依變數。最大記錄長度取決於儀器型
號和記錄長度選項。

前面版解析度旋鈕可以在自動和常態
取樣率模式下變更取樣率。

在「手動」模式下可以設定「取樣
率」和「記錄長度」。根據取樣率和
記錄長度計算出來的「水平刻度」是
相依變數。手動模式不支援遮罩。

「水平刻度」旋鈕可以變更手動模式
的記錄長度。
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如圖所示，這三個模式與取樣率、刻
度和記錄長度均有所互動。水平線是
最大即時取樣率。每個樓階顯示若將
刻度增加到最大記錄長度或記錄長度
限制，就必須減少取樣率。手動模式
使用最大記錄長度。

「自動」和「常態取樣率」模式是相
同的。但「常態取樣率」模式讓取樣
率維持在可以使用加強型頻寬濾波器
的常態取樣率。

使用 FastAcq
快速擷取模式可減少波形擷取之間的停工時間，以便擷取並顯示暫態訊號 (如突波或矮波脈衝)。快速
擷取模式也可反應發生率之強度來顯示波形狀態。

請使用下列程序：

1. 按下 FastAcq (快速擷取)。
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2. 尋找突波、暫態訊號或其他隨機
突波。

當您注意到異常狀況時，請設定觸
發系統來尋找它。(請參閱頁121，
捕捉間歇性異常)

快速秘訣

若要讓擷取明細或罕見事件達到最佳化，請選取 Horiz/Acq > Horizontal/Acquisition Setup > Acquisition>
Fast Acq (水平/擷取 >水平/擷取設定 >擷取 >快速擷取)，並在Capturing Details (擷取明細)或 Capturing
rare events (擷取罕見事件).選取 Optimize (最佳化)。

使用 DSP 加強型頻寬
如果儀器擁有加強型頻寬功能，您便可使用 DSP (數位訊號處理) 加強型頻寬進行更精確的上升時間測
量，以便擴充頻寬及拉平高取樣率時的帶通頻率。「加強型頻寬」可讓啟用的波道產生配比響應，供
您執行波道至波道比較及不同測量。

1. 按下 AUTOSET (自動設定)來設定
水平、垂直和觸發控制項，或是
手動設定控制項。
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2. 選 取 Vertical > Bandwidth En-
hanced...(垂直>加強型頻寬...)。

3. 按一下Digital Filters (DSP) Enhanced
(加強型數位濾波器 (DSP)，開啟加
強型頻寬。必須設定正確的取樣
率，才能啟用 DSP。

4. 若要強制執行可啟用DSP濾波器的
常態取樣率，請勾選Force Constant
Sample Rate (強制常態取樣率)。

注意。 若尚未設定，請選取「常態
取樣率」，將水平模式設定為常態取
樣率、將取樣率設定為允許 DSP，並
選取 DSP 頻寬。

5. 從 Bandwidth (頻寬) 清單中選取所
需要的頻寬。

可用的頻寬選項取決於儀器、探
棒和探棒頭。

選取 Analog Only (僅類比)，選取
硬體頻寬。

6. 若要將這些選擇套用到所有波道，
請勾選 Apply To All Channels (套用
到所有波道)。

如果探棒不同，儀器則無法將所
有波道設定成相同，但儀器會為
每個波道設定最接近的可能頻寬
值。
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當加強型頻寬啟動時，頻寬指示
器將顯示於垂直讀數中。

快速秘訣

在波形拖曳點上按一下滑鼠右鍵叫出功能表，選取波道頻寬和其他加強型頻寬設定。

此 DSP 加強型頻寬可在最大取樣率時執行。

請在訊號上升時間小於 50 ps 時使用 DSP 加強型頻寬。

如果要產生較多波形輸送量、過激訊號，或是您偏好使用自訂的 DSP 後置處理時，請選取 Analog
Only (僅類比)。

若要限制儀器頻寬，請選取 Vertical > Bandwidth Limit (垂直 > 頻寬限制)，再選取頻寬。

使用捲動模式
Roll (捲動) 模式將顯示類似低頻訊號的紙條圖表記錄器之畫面。捲動模式會直接顯示已擷取的資料
點，而不用等候擷取到完整的波形記錄。

1. 選取 Horiz/Acq > Horizontal/Acquisi-
tion Setup...( 水平/擷取>水平/擷取
設定...)。

2. 如果沒有選取的話，請按一下
Acquisition (擷取)索引標籤。按一
下Auto (自動)便可開啟 Roll (捲動)
模式。

注意。 Roll (捲動) 模式需要配合
Sample (取樣)、Peak Detect (峰值檢測)
或 Hi Res (高解析度) 等擷取模式。
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3. 如果要在 Roll (捲動) 模式停止擷
取：

如果不是使用 Single Sequence
( 單次程序 ) 模式，請按下
RUN/STOP (運行∕停止)來停
止 Roll (捲動) 模式。

如果是使用 Single Sequence (單
次程序)模式，Roll (捲動)模式
擷取會在擷取到完整記錄時自
動停止。

快速秘訣

切換至 Envelope (包封)、Average (平均)或WfmDB (波形資料庫)擷取模式將會關閉Roll (捲動)模式。

如果水平刻度設定為 50 ms/div 或更快時，Roll (捲動) 模式將會停用。

使用快速圖框模式
「快速圖框擷取」可在大筆記錄中將眾多觸發事件一筆一筆地擷取，並在之後分別檢視和測量每筆記
錄。Time Stamps (時間註記) 可以顯示特定圖框的絕對觸發時間，以及 2 個特定圖框觸發之間的相對時
間。

1. 按下 AUTOSET (自動設定) 以設定
水平、垂直與觸發控制項目，或
以手動方式設定這些控制項目。
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2. 選 取 Horiz/Acq > FastFrame
Setup...( 水平∕擷取>快速圖框設
定...)。

3. 按一下 FastFrame (快速圖框) On (
開啟)。

4. 選擇 Frame Size (圖框尺寸) 與
Events Frames (事件圖框)的數目。
接著使用多用途旋鈕來設定每一筆
記錄。圖框 數目代表將擷取之觸
發事件的數目。圖框 尺寸代表每
次觸發事件 (或圖框) 所要儲存的
取樣數目 。如果記憶體不夠儲存
所有記錄， 圖框計數就會減少。
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5. 使用 Frame Viewing (圖框檢視) 控
制項來選取要檢視的圖框。

6. 如果要檢視互相重疊的多個圖框，
請選取 Overlay (重疊)。

7. 使用 Time Stamps (時序註記) 控制
項來選取參考圖框的來源和圖框
數目。參考圖框是指測量二個圖框
之間相對時間所使用的起始點。

快速秘訣

當您要保留每次觸發事件的相關資料以供日後分析或目視檢驗時，請使用 FastFrane (快速圖框) 功
能。

當您想要擷取長停工時間中不特定的多個事件， 請使用快速圖框功能。

檢視多層圖框時最好是使用 Normal (一般)、Green (綠色) 或 Gray (灰色)調色盤。因為使用 Temp (溫
度) 或 Spectral (頻譜) 時，所選取的深藍色圖框可能不易辨識。
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使用 FastFrame (快速圖框) 圖框搜尋工具
圖框搜尋工具能讓您找到 與其他圖框不同的 FastFrame (快速圖框)。

1. 選擇 FastFrame (快速圖框) 圖框的
來源。

2. 輸入 From Frame # (起始圖框編號)
和 To Frame # (結束圖框編號) 以
設定「搜尋範圍」。

3. 按下 Run/Stop (運行/停止) 以 停止
擷取。

4. 按下 Start (啟動) 以 開始搜尋。

「圖框搜尋工具」能搜尋 並顯示不
同圖框。

5. 如果您所尋找的異常不在顯示的
圖框中，按下 No (否)。「圖框搜
尋工具」能搜尋 另一個不同的圖
框。

6. 如果您所尋找的異常在顯示的 圖
框中，按下 Yes (是)。

7. 如果您完成搜尋，則按下 Stop (停
止)。
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8. 按下 Run/Stop (運行/停止) 以重新
開始 擷取。

使用 TekLink 和 MultiScope 觸發
若要使 4 個以上的波道 與單一觸發事件結合，則要在一個波道中使用 4 個波道 來尋找問題，或使用
TekLink 建立一個擁有 4 個以上輸入端的大 AND 閘門。

注意。 當使用 MultiScope 觸發時，將無法使用 B 觸發。

連結兩個儀器

1. 使用一條 TekLink 纜線 連接兩個
儀器。

2. TekLink 連線狀態顯示於水平讀數
中。
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3. 選取 Trig > A Event (Main) Trigger
Setup...(觸發> A 事件(主要) 觸 發
設定...)。

4. 選擇 MultiScope Trigger (MultiScope
觸發) 索引標籤。

5. 選擇 Enable MultiScope Triggering
(with TekLink) (使用 TekLink 啟用
MultiScope 觸發)以啟用MultiScope
觸發。

6. 選擇 Sends Trigger (傳送觸發)以啟
用儀器來觸發儀器對儀器設定中
的 兩個儀器。另一個儀器則自動
設定為接收觸發。

若未使用集線器，則可以在提供
觸發的儀器上使用所有的觸發類
型。
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7. 若要校準 MultiScope 觸發，按下
Calibrate (校準) 按鈕。

連結多個儀器

可使用 TekLink 集線器連接兩個或以上的 儀器。

1. 使用 TekLink 集線器和纜線 連接
兩個或以上的儀器。

2. TekLink 連線狀態顯示於水平讀數
中。

3. 選取 Trig > A Event (Main) Trigger
Setup...(觸發> A事件(主要)觸發設
定...)。
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4. 選擇 MultiScope Trigger (MultiScope
觸發) 索引標籤。

5. 選擇 Enable MultiScope Triggering
(with TekLink) (使用 TekLink 啟用
MultiScope 觸發)以啟用MultiScope
觸發。

6. 選擇 Contribute (提供) 以 以啟用儀
器在 TekLink 設定時提供觸發。其
他 儀器則自動設定為接收觸發。

7. 在觸發所有 TekLink 設定中的儀器
之前，選擇 AND 或選擇 OR 以結
合 所有提供的 觸發。

含集線器的 AND 觸發適用邊緣和
模式觸發類型。

含集線器的OR觸發適用所有的觸
發類型。

8. 若要對齊 MultiScope 觸發，按下
Align (對齊) 按鈕。

9. 如果您要讓儀器掃描 TekLink 網
路以查看連接到 TekLink 網路的
儀器，按下 Refresh (重新整理) 按
鈕。

10. 當您啟用multiscope 觸發，則會顯
示於觸發讀數格中。
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Pinpoint 觸發

Pinpoint 觸發系統提供了 A 和 B 觸發都可應用的進階觸發方式。如果 B 事件沒有在特定事件數或特定
時間之後觸發，它可重置觸發程序。Pinpoint 觸發可依據最複雜的觸發事件或觸發事件程序來支援擷
取事件。

本節將介紹使用此觸發系統的概念和程序。

觸發概念

觸發事件

觸發事件會建立波形記錄中的時序零點。所有的波形記錄資料皆依時序零點的時間來定位。本儀器會
持續擷取並保留足夠的取樣點，來填滿波形記錄的前置觸發部份。當觸發事件一出現，儀器就會開始
擷取取樣，建立波形記錄的後置部份 (也就是在觸發事件之後、或其右邊的顯示部份)。一旦儀器確認
觸發，它就不會接受其他觸發。除非已完成擷取，而且延滯時間已到期。

觸發模式

若觸發事件沒有出現，觸發模式會決定儀器應採取的行動：

一般觸發模式限制示波器只在被觸發時才擷取波形。如果沒有觸發事件，螢幕將一直顯示上次擷
取到的波形記錄。如果上次沒有擷取任何波形，螢幕將不顯示任何波形。

自動觸發模式將使示波器自動擷取波形，即使沒有任何觸發。自動模式使用觸發事件發生之後開
始的計時器。若是在計時器逾時之前還未偵測到其他觸發事件，示波器就會強制觸發。觸發事件
的等候時間長度取決於時基設定。

自動模式缺乏有效觸發事件時所強制進行的觸發，不會和顯示中的波形同步。該波形會在整個螢幕上
捲動。如果發生了有效觸發，畫面就會穩定下來。

在 邊緣觸發模式中，您也可以按一下 Trigger Setup (觸發設定) 控制視窗中的 Force Trigger (強制觸發) 按
鈕來強制觸發儀器。

在 Trig > Mode (觸發>模式) 功能表中選取觸發模式。如需更多資訊，請參閱示波器線上說明。

觸發延滯

觸發延滯有助於穩定觸發， 藉由延長觸發期間，可在啟動擷取之後抑制進一步的 觸發辨識。這樣的
延長可幫助系統 跳過循環脈衝事件的剩餘事件，如此一來， 就可使每一次的脈衝皆觸發到第一個事
件。當儀器觸發到不想要的觸發事件時， 請調整延滯，以保持穩定觸發。

在 Trig > Holdoff (觸發>延滯) 功能表設定觸發延滯。如需更多資訊，請參閱示波器線上說明。
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觸發耦合

觸發耦合會決定要將哪個訊號部份傳遞給觸發電路。邊緣觸發可使用所有的耦合類型：交流、直流、
低頻排斥、高頻排斥和雜訊排斥。所有其餘觸發類型只能使用「直流耦合」。

在 Trig > A Event (Main) Trigger Setup (觸發 > A 事件 (主要) 觸發設定) 功能表中選取觸發耦合。如需更
多資訊，請參閱示波器線上說明。

水平位置

水平位置可定義波形記錄中觸發的發生位置。您可透過它來選擇儀器在觸發事件前後所要擷取的時間。
在觸發之前所發生的記錄部份，就是前置觸發部份。在觸發之後發生的部份，即為後置觸發部份。

前置觸發資料有助於故障排除。例如，如果您想了解為何測試電路產生不想要的突波，您可觸發該突
波，並使前置觸發期間長到足以擷取突波之前的資料。您可以分析該突波之前發生哪些現象，找出一
些資訊來研究其發生原因。如果您想了解觸發事件會對系統造成哪些影響，請加長後置觸發期間到足
以擷取觸發後的資料。

斜率和位準

斜率控制項定義示波器找到的訊號上升∕下降邊緣上的觸發點。位準控制項決定觸發點在邊緣上的發
生位置。

延遲的觸發系統

您可單獨觸發 A (主要) 觸發系統。或是結合 A (主要) 觸發和 B (延遲) 觸發後才觸發次序事件。如果是
使用次序觸發，A 觸發事件會啟動觸發系統。而當 B 觸發條件符合時，B 觸發事件就會觸發儀器。A
和 B 觸發可以 (通常也是如此) 具有不同的來源。B 觸發條件可根據時間延遲或特定事件數。
( 請參閱頁51，使用 A (主要) 和 B (延遲) 觸發)
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選擇觸發類型

本儀器讓您可從前面板修改基本的觸發參數，或在「觸發設定」控制視窗中設定更多進階的觸發。

注意。 有些觸發方式選項不適用於 某些儀器。

1. 按下 EDGE (邊緣)。

2. 設定訊號源、斜率和模式。如果
要設定耦合，請使用 Trig > Edge
Setup (觸發>邊緣設定) 功能表。

3. 如果要選取其他觸發方式，請執
行下列一項動作：

按下 ADVANCED (進階)。

直接從 Trig (觸發) 功能表選取
觸發方式。

4. 使用顯示觸發類型的控制項，完成
觸發設定。用來設定觸發的控制
項，將依觸發方式而有所不同。
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Pinpoint 觸發選項

觸發方式 觸發條件

邊緣 請依斜率控制項的定義，觸發上升或下降邊緣。耦合選擇可為直流、
交流、低頻排斥、高頻排斥和雜訊排斥。

突波 觸發比指定寬度更窄 (或更寬) 的脈波，或是忽略比指定寬度更窄 (更
寬) 的突波。

寬度 觸發指定時間範圍內∕外的脈波。您可在正脈波或負脈波上觸發。

矮波 觸發一脈波振幅。它可與第一個臨界值交叉，但再度交叉第一個臨界
值之前，無法與第二個臨界值相交。您可以偵測正矮波或負矮波，或
是只偵測比指定寬度還寬的矮波。這些脈波也可以被其他波道的邏輯
狀態限定。

視窗 當輸入訊號高於上方臨界水平或低於下方臨界水平時觸發。當訊號正
在進入或離開臨界視窗時觸發儀器。請使用 Trigger When Wider (較寬
時觸發) 選項，以時間來限定觸發事件。或視其他波道的邏輯狀態而
使用 Trigger When Logic (邏輯時觸發) 選項。

逾時 在指定時間內沒有偵測到任何脈波時觸發。

轉態 當脈波邊緣穿越兩個臨界值間的速率快∕慢於指定時間時，觸發脈波
邊緣。這種脈波邊緣可為正向或負向。

串列 在最快 1.25 Gb/s 資料速率的 64 位元串列樣式下觸發 (<4 GHz 型號)，
以及在最快 3.125 Gb/s (僅 ≥4 GHz 型號適用)或 5 Gb/s (≥4 GHz B 型號適
用)資料速率的 40位元串列樣式下觸發。鎖定虛擬隨機位元程序。需
配合 PTM 或 PTH 選項。 這個模式包含時脈還原。 按下 Push Set 50% (
按下設定 50%) 旋鈕可重新初始時脈還原。

「樣式鎖定」可自動尋找並鎖定長而重複的虛擬隨機位元程序 (Pseudo-
random bit sequence，PRBS)。這項鎖定表示儀器知道虛擬隨機位元程
序的位元長度，並可預測循環重複的時間。「樣式鎖定」可讓儀器以
具有顯著時基精確度的資料樣式在特定位置取樣。

模式 當邏輯輸入值使選定的函數成為 TRUE或 FALSE 時觸發。您也可以指
定：邏輯條件必須滿足特定次數後才觸發。

狀態 當所有邏輯輸入值使選定的函數成為 True 或 False 且時脈輸入值變更
狀態時觸發。

設定∕保持 當邏輯輸入值在時脈的設定時間及保持時間內改變狀態時觸發。模式
在設定和保持違反時觸發。

通訊 請結合 波罩測試在通訊碼和標準上觸發。您 可同時使用這些控制項
來定義觸發事件的參數 (需配合 MTM 或 MTH選項)。這個模式包含時
脈還原。按下 「Push Set 50%」(按下設定 50%) 旋鈕可重新初始時脈
還原。

視頻 觸發指定的圖場或合成視頻訊號線條。僅支援合成訊號格式。

SPI 觸發在序列周邊介面 (SPI) 訊號上。

I2C 請觸發下列內部 IC 控制項 (I2C) 訊號：開始、停止、重複開始、遺漏
確認、位址、資料，以及位址和資料。
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觸發方式 觸發條件

RS-232 觸發 RS-232 訊號。

CAN 觸發 CAN 匯流排訊號。

檢查觸發狀態
您可以從前面板狀態燈或讀值來檢查觸發狀態。

檢查ARM、READY和 TRIG’D等前
面板控制項來判斷觸發狀態。

如果 TRIG’D 燈亮起，表示儀器
已確認有效的觸發，且正在建構
波形的後置觸發部份。

如果 READY 燈亮起，表示儀器
可接受並正在等候有效的觸發發
生。前置觸發資料已取得。

如果ARM燈亮起，表示觸發電路
正在建構波形記錄的前置觸發部
份。

如果TRIG’D和READY都亮燈，
表示已確認有效的 A 事件觸發，
而且儀器正在等候延遲觸發。確
認延遲觸發後，將建構延遲波形
的後置觸發部份。

如果 ARM、TRIG’D 和 READY
燈都沒有亮起，表示擷取已經停
止。

若要快速判斷某些重要觸發參數的設
定，請檢查螢幕下方的觸發讀值。邊
緣觸發和進階觸發的讀值並不同：

1. A 觸發源 = Ch1

2. 觸發斜率 = 上升邊緣

3. 觸發位準

4. 時基
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使用 A (主要) 和 B (延遲) 觸發
您可以單獨使用簡單訊號的A事件 (主要) 觸發，或將它結合 B事件 (延遲) 觸發以擷取較複雜的訊號。
A 事件發生之後，觸發系統會先尋找 B 事件，然後才觸發和顯示波形。

A 觸發

1. 選取 Trig > A Event (Main) Trigger
Setup...(觸發> A 事件(主要) 觸 發
設定...)。

2. 在 A Event (A 事件) 索引標籤中設
定 A 觸發方式和來源。

B 觸發 (延遲)

注意。 在啟用MultiScope觸發時無法
使用 B 觸發。

3. 在 A →B Seq (A →B 次序) 索引標
籤中選擇函數。

4. 設定觸發延遲時間或B事件數量。
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5. 在 B Event (Delayed) (B 事件 (延遲))
索引標籤中設定 B 觸發特性。

6. 在 Mode (模式) 索引標籤中，選取
Normal (一般) 觸發模式和 Auto (自
動) 延滯。

觸發 B 事件

A 觸發會啟動示波器。後置觸發擷取
開始於第 n 個 B 事件。
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延遲時間後的 B 觸發

A 觸發會啟動示波器。在觸發延遲時
間之後的第一個B邊緣上開始後置觸
發擷取。

重置觸發

您可以指定當某條件在 B 觸發事件
前發生時，便重置觸發系統。重置事
件發生後，觸發系統即停止等候B事
件，並恢復成等候 A 事件。

快速秘訣

B 觸發延遲時間和水平延遲時間是各自獨立的功能。當您單獨使用 A 觸發或同時使用 A 和 B 觸發
建立觸發情況時，您也可以使用水平延遲進行額外數量擷取的延遲。

更正觸發位置

「觸發位置更正」可更正資料路徑和觸發路徑上的偏差，更精確地將觸發放在顯示的波形上。「觸發
位置更正」也可使用平均，更精確地將觸發放在雜訊訊號上。若要更精確地將邊緣觸發放在畫面上，
請執行下列程序：
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1. 若要更精確地將觸發放在畫面上，
請勾選 Enhanced Triggering (加強型
觸發)。若要更精確地將觸發放在
雜訊訊號上，也請勾選 Optimized
for Noisy Signals (針對雜訊訊號最
佳化)。

若要勾選Optimized for Noisy Signals
(針對雜訊訊號最佳化)，必須先
勾選 Enhanced Triggering (加強型觸
發)。

依觸發傳送電子郵件
您必須先設定「依事件發出電子郵件」，才能執行下列程序。 ( 請參閱頁129，設定「依事件發出電
子郵件」)

1. 選取 Trig > A Event (Main) Trigger
Setup...(觸發> A事件(主要)觸發設
定...)。

2. 選取 Mode (模式) 索引標籤。

3. 在 E-mail on Trigger (依觸發傳送電
子郵件)表下，按一下On (開啟)，
再按一下 Setup (設定)。 ( 請參閱
頁129，設定「依事件發出電子郵
件」)
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使用水平延遲

使用水平延遲，可在重要時間間隔分
隔的觸發位置區域中擷取波形細節。

1. 按下 DELAY (延遲)。

2. 使用水平 POSITION (位置) 控制項
來調整延遲時間，或在控制視窗
輸入延遲時間。

3. 調整水平 SCALE (刻度)來擷取所
需細節。

快速秘訣

您可同時使用 MultiView 縮放和水平延遲功能來放大延遲的擷取。

開啟和關閉水平延遲功能，便可快速比較在兩個不同重要區域的訊號細節。一個是接近觸發區域，
另一個則位在延遲時間的中央。
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顯示波形

本節將介紹顯示波形的概念和程序。線上說明將提供詳細資訊。

設定顯示樣式

如果要設定顯示樣式，請選取 Display
> Display Style (顯示>顯示樣式)，再選
取下面一種樣式：

在記錄點和點之間畫
線來顯示波形。

將波形記錄點顯示為
螢幕上的點。

顯示實際取樣。不顯
示內插產生的點。
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設定持續顯示

選取 Display > Display Persistence (顯示
> 持續顯示) 以選取持續方式。

不持續設定將只顯示目前擷取的
記錄點。每筆新的波形記錄都會
取代前一個擷取到的波道記錄。

無限餘輝會持續累積記錄點，直
到您改變其中一個擷取顯示設定。
用於顯示出現在一般擷取包封以
外範圍的點。

可變餘輝指定了時間間隔的記錄
點。每個記錄點會根據時間間隔
個別消失。

重置餘暉可清除餘暉。

1. 如果要設定可變餘暉，請選取
Display > 顯示 餘暉 > 餘暉控制... (
顯示>顯示餘暉>餘暉控制項...)。

2. 按一下Variable (可變)、Persist Time
(持續時間)，再使用多用途旋鈕來
設定持續時間。
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設定顯示格式
本儀器可以顯示三種不同的波形格式。請選擇最適合您需求的格式。

選取Display > Display Format (顯示>顯
示格式)。

選取YT格式，可顯示隨時間而不
同的訊號振幅。

選取 XY 格式，便可 逐點比較波
形記錄的振幅：

比較下列波道：

Ch 1 (X) 和 Ch 2 (Y)、

Ch 3 (X) 和 Ch 4 (Y)、

Ref 1 (X) 和 Ref 2 (Y)、

Ref 3 (X) 和 Ref 4 (Y)

選取 XYZ 格式，便可如同在 XY
格式般，逐點比較Ch 1 (X) 和 Ch 2
(Y) 波形記錄的電壓位準。顯示的
波形強度由 Ch 3 (Z) 波形記錄來調
變。觸發 XYZ 格式。Ch 3 上的 -5
分格訊號 (包含位置和偏移) 產生
空白螢幕，+5 分格訊號產生完全
強度。

快速秘訣

XY 格式在判讀如李塞爾氏圖形 (Lissajous Pattern) 的相位關係時特別有用。

XY 格式是僅顯示點的顯示格式，雖然這種格式也具有持續性。如果是選取 XY 格式，「向量樣
式」不會產生任何作用。
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選取波形內插法

選取 Display > Waveform Interpolation
( 顯示> 波形內插法)，再選取下面
一項方法：

Sin(x)/x 內插法會應用最佳曲線，
計算出介於實際擷取取樣之間的
記錄點。

Linear (線性) 內插法會應用最適直
線，計算出介於實際擷取取樣之
間的記錄點。

快速秘訣

Sin(x)/x 內插法是預設的內插模式。比起線性內插法，它在準確呈現波形時所需的實際取樣點數較
少。

增加螢幕文字

1. 選取 Display > Screen Text (顯示>螢
幕文字)。
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2. 最多可輸入 8 行 (分開) 文字。

3. 按一下 Text (文字) 的 Off (關閉) 或
On (開啟)，便可開啟或關閉文字
顯示。

4. 按一下Font (字型)或Color (色彩)，
便可選取螢幕文字的字型和色彩。

5. 按一下 Controls (控制)，便可開啟
「文字內容」控制視窗來設定顯
示中的文字位置。

6. 按一下 Clear (清除)，便可消除選
定行的所有文字。

快速秘訣

您可以從螢幕上按一下並拖曳螢幕文字，為其重新定位。
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設定方格圖樣式

如果要設定方格圖樣式，請選取 Dis-
play > Graticule Style (顯示>方格圖樣
式)，再選取下面一種樣式：

用於快速估計波形參
數。

用於不需要十字線
時，顯示包含游標和
自動讀值的全螢幕測
量值。

用於快速估計波形，
以便留下更多空間
給自動讀值和其他資
料。

用於不需要顯示功能
時，顯示自動讀值和
其他螢幕文字。

用於顯示 NTSC 視頻
訊號。

用於顯示非 NTSC 的
其他視頻訊號。

設定觸發位準標記

1. 請選取 Display > Objects... (顯示>
物件...)。

2. 選取下列選項之一：

選項Short (短)：在方格圖旁邊
顯示短箭頭。

選項 Long (長)：顯示橫跨方格
圖的水平線。

選項Off (關閉)：關閉觸發位準
標記。
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顯示日期和時間

1. 選取 Display > Objects... (顯示>物
件...)。

2. 切換方格圖中 Date/Time (日期/時
間) 的顯示。使用 Utilities (公用程
式) 功能表來設定日期和時間。

使用調色盤

選取Display > Record View Palette (顯示
>記錄檢視調色盤)或 FastAcq/WfmDB
Palette (快速擷取∕波形資料庫調色
盤)，再選取波形和方格圖的色彩組
合之一：

Normal (一般) 選項將顯示最佳整
體檢視的色調和亮度。每個波道
波形的顏色皆符合前面板垂直旋
鈕的對應色彩。

Temperature Grading (溫階) 選項會
以紅色來顯示出現最高取樣密度
的波形區域。最低取樣密度的區
域則呈現為藍色。

Monochrome (單色綠色) 選項以淺
綠色來顯示出現最高取樣密度的
波形區域。最低取樣密度的區域
則呈現深綠色。這很仿似類比示
波器的顯示顏色。

Spectral Grading (頻譜層次) 選項以
藍色來顯示出現最高取樣密度的
波形區域。最低取樣密度的區域
則呈現紅色。
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Monochrome Gray (單色灰色) 選項
以淺灰色來顯示出現最高取樣密
度的波形區域。最低取樣密度的
區域則呈現深灰色。

User (使用者) 選項以使用者定義
色彩來顯示波形。

快速秘訣

在Display > Colors (顯示>色彩)控制視窗中選擇其中一組色階調色盤，便可查看不同顏色代表的不同
取樣密度。

調色盤有二種。一種用於 Record View (記錄檢視)，另一種用於 FastAcq/WfmDB (快速擷取∕波形資
料庫)。

設定參考色彩

選取Display > Colors...(顯示>色彩...)，
再選取下列方法之一：

Default (預設)：使用參考波形預設
的系統色彩。

Inherit (沿用)：使用相同於原參考
波形的色彩。
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設定算術運算色彩

選取 Display > Colors...( 顯示＞色
彩...)，然後選擇下列選項其中之一：

Default (預設)：使用算術運算波形
預設的系統色彩。

Inherit (沿用)：使用相同於套用數
學函數之最小編號波道波形的色
彩。

快速秘訣

每個算術運算波形和參考波形使用不同的預設色彩。

使用 MultiView 縮放
使用 MultiView Zoom 功能，可垂直、水平、或等比例放大波形尺寸。縮放過的波形也可以排列、鎖定
和自動捲動。Scale (刻度) 和 Position (位置) 設定只會影響畫面，而不會影響到實際波形資料。

1. 按下 MultiView Zoom 可分割螢幕
並加入縮放方格圖。
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2. 按下 HORIZ (水平) 或 VERT (垂
直)，可選擇要放大縮放方格圖中
哪一條軸線。使用多用途旋鈕可
調整放大波形的刻度和位置。

這個範例的主要方格圖是方格圖
的上半部，縮放方格圖是方格圖
的下半部。

注意。 若要隱藏或顯示縮放波形，請
按 Waveforms (波形) 的 Hide (隱藏)，
再勾選要顯示的縮放波形。

3. 如果要調整縮放方格圖尺寸，請
從Vertical (垂直)或Horiz/Acq (水平
∕擷取)功能表選取 Zoom Graticule
Size (縮放方格圖尺寸)。

4. 如果要關閉縮放功能，請按下前
面板相關按鈕。

快速秘訣

您也可以使用 Zoom Setup (縮放設定) 功能表來變更縮放波形的方格圖尺寸。
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在多塊區域縮放
如果您想同時檢視和比較同一筆記錄中的多塊區域，請使用下列程序。

1. 在您想要縮放的波形區域周圍按
一下滑鼠，拖曳出一個矩形。

2. 選取 Zoom 1 On (縮放 1 開啟)。

3. 在另一個要縮放的波形區域周圍按
一下滑鼠，拖曳出一個矩形，然
後選取 Zoom 2 On (縮放 2 開啟)。

4. 如果要水平調整縮放區域，請按一
下該縮放矩形下方的水平標記，
以選取縮放區域。

5. 請使用多用途旋鈕來調整選定縮
放波形的水平位置和縮放係數。
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6. 如果要垂直調整該縮放區域，請
選取Vertical > Zoom Setup...(垂直>
縮放設定...)，按一下垂直圖場，
再使用多用途旋鈕來調整垂直位
置和縮放係數。

快速秘訣

如果要清除縮放區域，請按一下 Zoom Setup (縮放設定) 控制視窗中的 Position Factor Reset (位置係數
重置)。

您可以從 Zoom Setup (縮放設定) 控制視窗開啟、關閉每個縮放顯示。

按下 MultiView Zoom 按鈕可切換全部的縮放顯示開關狀態。

如果要重新定位縮放區域的水平位置，請按一下並拖曳縮放矩形底部的水平標記。

鎖定和捲動縮放波形

1. 如果要使用 Lock and Scroll (鎖定
和捲動)，請在 Vertical (垂直) 或
Horiz/Acq (水平∕擷取) 功能表選
取Zoom Setup...(縮放設定...)，再選
取 Lock and Scroll (鎖定和捲動)索
引標籤。

2. 如果要捲動單一縮放區域，請選
取 Zoom 1-4 (縮放 1-4)核取方塊，
再按一下Auto Scroll (自動捲動)按
鈕。
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3. 如果要同時捲動多塊縮放區域，
請按一下 Lock (鎖定)，再選取
Zoom 1-4 (縮放 1-4) 核取方塊。

鎖定縮放區域可鎖定它們的相對
水平位置。改變一個已鎖定縮放
區域的水平位置，就會改變全部
的水平位置。

快速秘訣

如果只有選取多塊縮放區域卻沒有鎖定，最大編號的縮放區域將自動捲動，而其他縮放區域則維
持不動。
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隱藏縮放視窗中的波形

1. 若要隱藏或檢視波形，請從 Ver-
tical (水平) 或 Horiz/Acq (水平∕擷
取)功能表選取 Zoom Setup... (縮放
設定...)，按 Controls (控制)，再按
Waveforms (波形) 的 Hide (隱藏)。

2. 選取要顯示或隱藏的波形所在的
縮放區域。

3. 取消勾選您要隱藏的波道、算術
運算或參考波形。
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搜尋和標記波形
您可以從擷取的波形來標記特定的位置。這些標記有助於限制自己分析特定波形區域。您可以自動標
記符合特殊條件的波形區域，或是手動標記每個特定項目。您可以在標記之間跳躍移動 (在特定區域
之間移動)。Advanced Search and Mark (進階搜尋和標記) 選項可自動搜尋並標記許多可觸發的參數。許
多搜尋參數沒有觸發的時間限制。您可以搜尋算術運算和參考波形。您可以尋找特定類型的所有擷取
事件。

搜尋標記提供了標記波形區域來作為參考的方式。您可以使用搜尋條件，自動設定標記。您可以使用
特定邊緣、脈波寬度、矮波、邏輯狀態、上升/下降時間、設定和保持違反以及匯流排等搜尋類型，
搜尋並標記區域。

若要手動設定並清除 (刪除) 標記：

1. 按Multiview Zoom。Zoom 1 (縮放 1
) 使用標記。

2. 選取 Analyze > Search (分析 > 搜
尋)。
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3. 旋轉多功能旋鈕，移動 (縮放方塊)
到您要設定 (或清除) 搜尋標記的
波形區域。

按下Next (下一個)或 Prev (上一個)
按鈕，跳到現有標記。

4. 按下 Set Clr (設定/清除)。

如果螢幕中央沒有出現任何搜尋
標誌，儀器就會增加一個標誌。

建立標記後，則會儲存水平縮放
係數。使用 Next (下一個) 或 Prev
(上一個)按鈕在標記之間移動時，
則會還原縮放係數。
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5. 在搜尋標記之間移動，調查研究
您的波形。使用 Next (下一個) 或
Prev (上一個)按鈕，可從一個標記
位置跳到另一個標記位置，而無
須調整其他任何控制項。

6. 刪除標記。按下 Next (下一個) 或
Prev (上一個) 按鈕，跳到要清除
的標記。若要移除置中位置的標
記，只需按下Set Clr (設定/清除)
即可。這對於手動與自動建立的
標誌都有用。

若要自動設定並清除 (刪除) 搜尋標記：

1. 選取 Analyze > Search (分析 > 搜
尋)。

2. 從功能表選取所需要的搜尋類型。

搜尋功能表很類似觸發功能表。

邊緣類型是標準項目；其他搜尋
類型是選用項目。
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3. 從 Configure (組態) 索引標籤設定
搜尋。若要複製觸發設定或搜尋
設定，請按下 Settings Copy (設定
複製)。

4. 從 Copy Settings (複製設定)視窗選
取設定的複製來源和複製目的地。
按 Copy (複製)，再按 Close
(關閉)。

5. 若要修改目前的搜尋設定，請調
整所顯示的控制項。顯示的控制
項因您選取的搜尋而異。

6. 如果尚未開啟，請按 Search (搜
尋)，切換成開啟搜尋。
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7. 在這個螢幕中，三角形表示自動
標誌的位置，白色三角形則表示
自訂 (使用者定義) 的標誌位置。
這些標誌都可出現在一般或縮放
過的波形檢視。

8. 若要快速調查研究波形，請使用
Next (下一個) 和 Prev (上一個) 箭
頭按鈕，在標記之間移動。不需
要其他調整。

9. 若要切換顯示搜尋事件計數或標
記時間，請選取 Results (結果) 索
引標籤，並按View (檢視)的 Count
(計數)。

10. 若要清除表格的所有標記，請按
All Marks (所有標誌) 的 Clear (清
除)。

11. 若要將標記表匯出至檔案，請按
All Marks (所有標誌) 的Export (匯
出)。
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12. 若要將一個或所有標記轉換為使
用者標記，請按 Search Marks (搜
尋標記) 的 Save (儲存) 或 Save All
(存全部)。

13. 若要從標記表中移除目前反白的
資料列，請按 Search Marks (搜尋
標記) 的 Clear (清除)。

14. 若要切換以工程表示法或以高精
準度表顯示標記位置，請按 Digits
(位數)。

15. 若要切換開啟和關閉顯示標記三
角形，請選取 View (檢視) 索引標
籤，並按Show Marks (顯示標記)。
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16. 若要在找到符合項目時停止擷取，
請選取 Mode (模式) 索引標籤，並
勾選 Stop Acquisition if event found
(找到事件便停止擷取)。

快速秘訣:

只搜尋擷取到的資料。設定儀器擷取您正在搜尋的資料。

設定可辨別搜尋事件的取樣率。您可以搜尋大於一些取樣間隔的突波。

您可以複製觸發設定，在擷取波形中搜尋符合觸發條件的其他位置。您可以複製搜尋設定到觸發。

建立邊緣搜尋標記時不需要縮放係數。其他搜尋類型使用適當的縮放係數建立標記。

按 Bring Zoom to Mark (縮放標記) 的 Zoom 2 (縮放 2) 或 Zoom 3 (縮放 3)，可使用 Zoom 1 (縮放 1) 的
縮放參數，顯示對應的縮放檢視。

在儲存波形以及儲存設定時，自訂 (使用者) 標記就會隨波形一起儲存。

當儲存波形時，自動搜尋標記不會隨著波形一起儲存。但是，您可以再使用搜尋功能，輕鬆地重
新擷取這些標記。

搜尋條件會儲存在儲存設定中。

「搜尋」有下列搜尋功能：

搜尋 說明

邊緣 搜尋具有使用者指定臨界值位準的邊緣 (上升或下降)。

突波 搜尋比指定寬度更窄 (或更寬) 的脈波，或是忽略比指定寬度更窄 (更寬) 的
突波。

脈波寬度 搜尋 >、<、= 或 ≠ 使用者指定之脈波寬度的正脈波寬度或負脈波寬度。

設置&保持 搜尋使用者指定的設定和保持時間違反。

矮波 搜尋正脈波或負脈波，它可與第一個振幅臨界值交叉，但再度交叉第一個
臨界值之前，無法與第二個臨界值相交。搜尋所有矮波脈波或只搜尋期間
>、<、= 或 ≠ 使用者指定時間的矮波脈波。

視窗 搜尋進出臨界值視窗的訊號。請使用 When Wider (較寬時) 選項，以時間來
限定搜尋。或視其他波道的邏輯狀態而使用 When Logic (邏輯時) 選項。

樣式 搜尋多個波形間的邏輯樣式 (AND、OR、NAND 或 NOR)，每個輸入設定為
High (高)、Low (低) 或 Don’t Care (無關)。當事件在 >、<、= 或 ≠ 使用者
指定時間為真、為假或有效時，進行搜尋。此外，您必須將其中一項輸入
定義為同步 (狀態) 搜尋的時脈。

轉換 搜尋 >、<、= 或 ≠ 使用者指定時間的上升和/或下降邊緣。

逾時 搜尋指定時間內沒有任何脈波。
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搜尋 說明

狀態 當所有邏輯輸入值使選定的邏輯函數成為真或假且時脈輸入值變更狀態時，
進行搜尋。
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分析波形

本儀器提供了游標、自動測量、統計、長條圖、算術運算、頻譜分析和進階的通過∕失敗測試等功
能，以協助您分析波形。本節將介紹分析波形的概念和程序。線上說明將提供詳細資訊。

進行自動測量

1. 選取Measure > Measurement Setup...(
測量>測量設定...)。

2. 選取您要測量的波道、算術運算
或參考波形。

3. 請使用這些索引標籤來選取 5 種
不同類別的測量。

4. 若要移除所有量測值， 按一下
Clear All (清除全部)。

5. 若要移除多筆測量值，按一下並
拖曳來選擇 測量值，然後按一下
Clear Selected (清除所選測量值)。
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您也可以直接在 Measure (測量) 功
能表選擇所選波形的測量值。 (請
參閱頁80，自動測量選項)

快速秘訣

使用捲動模式時，您必須等到擷取停止之後，才可以看到測量值。
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自動測量選項
下表列出每個自動測量類型：幅度、時間、更多、長條統計圖或是通訊。 (請參閱頁78，進行自動測量)

振幅測量值

測量 說明

振幅 整個波形或閘控區域的高值減去低值後，所得到的值。

高 在測量上升或下降時間這類需要用到高參考、中參考或低參考值的情況下，這個
值就會當作 100%使用。這個值可使用最小值∕最大值、或長條圖方法計算得出。
最小值∕最大值方法會使用實際找到的最大值。長條圖方法會使用實際找到最常
超過中點的值。這個值可由測量整個波形或閘控區域得到。

低 在測量上升或下降時間這類需要用到高參考、中參考或低參考值的情況下，這個
值就會當作 0% 使用。這個值可使用最小值∕最大值、或長條圖方法計算得出。
最小值∕最大值方法會使用實際找到的最小值。長條圖方法會使用實際找到最常
低於中點的值。這個值可由測量整個波形或閘控區域得到。

RMS 整個波形或閘控區域的真均方根電壓。

AC RMS 測量區域上的真「均方根」電壓。

最大 通常是最大正峰值電壓。最大值可由測量整個波形或閘控區域得到。

最小 通常是最大負峰值電壓。最小值可由測量整個波形或閘控區域得到。

峰對峰 整個波形或閘控區域中，最大和最小振幅的絕對差值。

週期均方根 波形第一個週期或是閘控區域第一個週期的真均方根電壓。

正過激 這是測量整個波形或閘控區域所得的測量值。可由下列運算式得出：
正過激量 = ((最大值 – 高值) / 幅度) x 100%。

負過激 這是測量整個波形或閘控區域所得的測量值。可由下列運算式得出：
負過激量 = ((低值 – 最小值) / 幅度) x 100%。

平均 整個波形或閘控區域的代數平均值。

週期平均 波形第一個週期或是閘控區域第一個週期的代數平均值。

時間測量值

測量 說明

上升時間 波形或閘控區域中第一個脈波上升邊緣，從最後值的低參考值 (預設 = 10%) 爬升
到高參考值 (預設 = 90%) 所需要的時間。

下降時間 波形或閘控區域中第一個脈波下降邊緣，從最後值的高參考值 (預設 = 90%) 下降
到低參考值 (預設 = 10%) 所需要的時間。

正脈波寬 正脈波中參考 (預設 50%) 振幅點之間的相隔距離 (時間)。測量波形或閘控區域的
第一個脈波，就可知道測量值。

負脈波寬 負脈波中參考 (預設 50%) 振幅點之間的相隔距離 (時間)。測量波形或閘控區域的
第一個脈波，就可知道測量值。

正工作週期 正脈波寬度和訊號週期的比率，以百分比例表示。測量波形或閘控區域的第一個
週期，就可知道工作週期。

負工作週期 負脈波寬度和訊號週期的比率，以百分比表示。測量波形或閘控區域的第一個週
期，就可知道工作週期。

週期 完成波形或閘控區域中第一個週期所需要的時間。週期是頻率的倒數；以秒鐘為
測量單位。
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時間測量值 （待續）

測量 說明

頻率 波形或閘控區域中第一個週期的頻率。頻率是週期的倒數；它的測量單位是 Hertz
(Hz)，1 個 Hz 指每秒鐘一個週期。

延遲 兩個不同波形中參考 (預設 50%) 振幅點之間的相距時間。

其他測量值

測量 說明

面積 整個波形或閘控區域的面積。單位為伏特-秒。測量基線以上的面積是正值；測
量基線以下的面積是負值。

週期面積 這是指波形第一個週期或閘控區域第一個週期的區域面積。單位為伏特-秒。測量
高於一般參考點面積會得到正值，測量低於一般參考點面積會得到負值。

相位 特定波形超前、或落後另一個波形的時間長度，以度來表示。這時 360° 代表整個
波形週期。

爆衝寬度 爆衝 (一連串暫態事件) 期間時間，可測量整個波形或閘控區域得知。

長條圖測量值

測量 說明

Wfm Ct 顯示構成長條圖的波形數目。

矩形中的命中數 顯示出現在長條圖矩形中∕上的點數。

峰命中數 顯示長條圖中最大集區出現的點數目。

中值 顯示長條圖矩形的中間點。位在長條圖矩形之內和之上的所有擷取點值中，有一
半小於這個值，而另一半大於這個值。

最大 顯示垂直長條圖中非零值 bin 的最高電壓，或水平長條圖中最右邊非零值 bin 的
時間。

最小 顯示垂直長條圖中非零值 bin 的最低電壓，或水平長條圖中最左邊非零值 bin 的
時間。

峰對峰 顯示長條圖的峰對峰值。垂直長條圖顯示最高非零值 bin 的電壓減去最低非零值
bin 的電壓。水平長條圖顯示最右邊非零值 bin 的時間減去最左邊非零值 bin 的時
間。

平均 測量長條圖矩形內∕上所有擷取點的平均值。

標準差 測量長條圖矩形內∕上所有擷取點的標準偏差值 (均方根 (RMS) 偏差值)。

平均 ±1 標準差 顯示與長條圖平均不超過 1 個標準差的擷取點百分比。

平均 ±2 標準差 顯示與長條圖平均不超過 2 個標準差的擷取點百分比。
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長條圖測量值 （待續）

測量 說明

平均 ±3 標準差 顯示與長條圖平均不超過 3 個標準差的擷取點百分比。

通訊測量值

測量 說明

消光比 眼球頂部至基準線的比例。這項測量只能用於波形資料庫，或波形資料庫模式下
已儲存的參考波形。

消光比 % 眼球基準線至頂部的比例。單位為百分比例。這項測量只能用於波形資料庫，或
波形資料庫模式下已儲存的參考波形。

消光比 (dB) 眼球頂部至基準線的比例。單位為分貝。這項測量只能用於波形資料庫，或波形
資料庫模式下已儲存的參考波形。

眼高度 測量眼高度。單位為伏特。

眼寬度 測量眼寬度。單位為秒鐘。

眼頂點 用於測量消光比的頂部值。

眼基準線 用於消光比量測中的基準值。

交叉 % 眼狀圖交叉點。以眼高度的百分比表示。

抖動 P-P 目前水平單位中邊緣抖動的峰對峰值。

抖動 RMS 目前水平單位中邊緣抖動的 RMS 值。

抖動 (6 Sigma) 目前水平單位中邊緣抖動 RMS 值的 6 倍值。

雜訊 P-P 指定訊號頂部或基準的雜訊峰對峰值。

雜訊 RMS 指定訊號頂部或基準的 RMS 值。

S/N 比例 指定訊號頂部或基準的訊號振幅和雜訊比例。

週期失真 在中參考所測量第一個眼狀圖交叉的峰對峰時序變化。單位為眼球週期的百分比
例。

Q 係數 眼球尺寸至雜訊比例。

自訂自動測量
您可以使用範圍、修改測量統計、或是調整測量參考位準，來自訂自動測量。
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範圍

使用範圍來限制測量於波形的特定部
分。

1. 選取 Measure > Gating > Gating (測
量>範圍>範圍) ...。

2. 請執行下列動作之一來指定範圍：

按一下 Cursor (游標)，將閘控
區域設定為游標間的區域。

按一下Zoom (1-4) (縮放 (1-4)，
將閘控區域設定為 Zoom (1-4)
( 縮放 (1-4)) 方格圖。

統計

統計功能可自動啟動測量。統計值可
顯示測量的穩定性。

1. 如果要改變顯示的統計值，請選取
Measure > Statistics (測量>統計)，再
選取 Mean (平均值)或 All (全部)。
(全部 選項包括了最小值、最大
值、平均值、標準差和總數。)

2. 如果要關閉統計功能，請選取 Off
(關閉)。
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快照

如果要一次查看全部有效測量，請選
取Measure > Snapshot (測量>快照)。

注意。 如果測量的設定無效，測量
結果顯示 3 個問號。

若要快照一般測量或通訊測量，請選
取 General (一般) 或 Comm (通訊)。

註解測量

1. 若要註解測量，請從Measurements
setup (測量設定) 控制視窗選取
Annotation (註解)。從下拉式選單
選擇測量以進行註解。
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2. 若要選擇測量註解的 詳細資訊數
量，請選擇 Measure > Annotation >
Standard (測量 > 註解) 或 Detailed
(詳細資料)。
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參考位準

參考位準會決定和時間相關的實際測
量結果。

1. 選 取 Measure > Reference Lev-
els...( 測量>參考位準...)。

2. 將測量參考水平調整到不同的相
對值或絕對值。

使用高、低參考來計算上升
和下降時間。預設的高參考是
90%，低參考是 10%。

Mid (中) 參考主要用於邊緣之
間的測量，例如脈波寬度。預
設水平為 50%。

Mid2 (中2)參考則用於延遲或相
位測量所指定的第二個波形。
預設水平為 50%。

快速秘訣

為確保精準的雜訊數值，請務必在測量 Eye (眼)狀圖訊號時，將訊號類型設定成 Eye (眼)狀圖訊號。

進行游標測量
使用游標來測量所擷取到的資料。

1. 按下 Cursors (游標)。
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2. 選取 Cursor Source (游標來源)。

3. 請選取下列游標類型之一：

HBars (水平線條)：可測量振幅
(通常單位為伏特或安培)

V Bars (垂直線條)：可測量水平
參數 (時間)

Waveform (波形)游標和 Screen (
螢幕)游標可以同時測量垂直和
水平參數。波形游標可附加到
波型中。而螢幕游標只能浮動
在波形上，無法附加到其中。

4. 如果要在二種波形之間進行測量，
請選取 Waveform (波形)，再一一
選取游標的波形來源。

DPO7000 系列和 DPO/DSA70000/B 系列快速入門使用者手冊 87



分析波形

5. 請 選 取 Cursors > Cursor Posi-
tion...( 游標>游標位置...)，再使用
多用途旋鈕來調整游標位置。

6. 於畫面讀取游標測量結果。

快速秘訣

請使用 Cursor Track (游標追蹤)模式以設定游標串聯地移動。請使用 Cursor Independent (游標獨立)模
式以設定游標個別地移動。

如果您使用縮放方格圖，可以直接放置游標在特定波形點以便進行精確測量。

也可用游標按一下並拖曳它們到新的位置。

若要將游標移到畫面中央，請按 Move Cursors to Center (將游標移到中央)。

您可以選取實線游標或虛線游標。

Vertical (垂直) 游標會測量從觸發點到垂直游標的時間。
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設定長條圖
您可以顯示垂直 (電壓) 或水平 (時間) 長條圖。使用長條圖測量，可以在特定軸線上取得波形區段的
統計測量資料。

1. 按一下指標並拖曳通過您希望長
條圖涵蓋的波形區段。如要設定
水平長條圖，則使矩形的寬度長
於高度。

2. 從捷徑功能表中選取 Histogram
Vertical (長條圖垂直)或 Histogram
Horizontal (長條圖水平)。

3. 在方格圖的頂點 (可檢視水平長條
圖) 或左邊緣檢視長條圖 (可檢視
垂直長條圖)。
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4. 如果要調整長條圖刻度、或長
條圖矩形的尺寸和位置，請選取
Measure > Waveform Histograms (測
量>波形長條圖)，再使用Histogram
Setup (長條圖設定) 控制視窗。

5. 您也可以在長條圖資料上執行自
動化測量。 (請參閱頁78，進行自
動測量)

快速秘訣

請使用垂直長條圖來測量訊號雜訊；使用水平長條圖來測量訊號抖動。

按一下並拖曳捷徑功能表，便可關閉長條圖顯示。

使用算術運算波形
建立算術運算波形，支持您對波道和參考波形的分析。您可以結合並轉換來源波形和其他資料到算術
運算波形，衍生在應用時所需要的資料檢視。

使用下列程序來取得預先定義的算術運算式。

1. 選取 Math > Math Setup...(算術運算
>算術運算設定...)。
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2. 選擇預先定義的算術運算式之一。

使用下列程序來建立進階的算術運算波形運算式。

1. 選取 Math > Math Setup...(算術運算
>算術運算設定...)。

2. 按一下 Editor (編輯器)。

DPO7000 系列和 DPO/DSA70000/B 系列快速入門使用者手冊 91



分析波形

3. 使用來源、運算子、常數、測量
值、變數以及函數來建立算術運
算波形運算式。

4. 當您定義出滿意的運算式之後，
請按一下 Apply (套用)。

5. 如果要新增個人的濾波器，請按
一下 Filter (濾波器) 索引標籤。按
一下 Load (載入)。

6. 按兩下所要使用濾波器的資料夾。
按兩下您想使用的濾波器。
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7. 使用所選定的濾波器來 建立個人
的算術運算式。

8. 當您定義出滿意的運算式之後，
請按一下 Apply (套用)。

快速秘訣

如果來源不是有效資料，則無法套用算術運算的定義。

算術運算波形可從波道、參考、算術運算來源波形、及測量值建立。

算術運算波形也可用波道波形的相同方式，進行測量。

算術運算波形可從算術運算式中的原始資料，衍生其水平刻度和位置。調整來源波形的控制項也
可以調整算術運算式。

您可以使用 MultiView Zoom 來放大算術運算波形；請使用滑鼠來設定縮放區域的位置。

如需更多有關任意算術濾波器的資訊，請參閱 線上說明。

使用頻譜分析
使用下列程序來取得預先定義的頻譜算術運算式。如需更多資訊，請參閱線上說明。

1. 選取 Math > Math Setup...(算術運算
>算術運算設定...)。
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2. 選擇預先定義的頻譜算術運算式
之一。

3. 按一下 Basic (基本)。

4. 按一下 Resolution BW (解析度頻寬)
或 Frequency Span (頻展)，並使用
數字鍵盤或多用途旋鈕來調整頻
譜顯示。

注意。 解析度 BW 和頻率頻展區只
能在手動水平模式中調整。

使用下列程序來建立進階的頻譜算術運算式。

1. 選取Math > Advanced Spectral...(算
術運算>進階頻譜...)。
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2. 選取您要定義的算術運算波形。

3. 按一下您要建立的頻譜波形類型。
如果要重新定義波形，請按一下
Clear (清除)。

4. 選取來源波形。

5. 使用 Spectral Setup (頻譜設定)控制
視窗及多用途旋鈕，來調整頻譜
波形。

6. 您可以同時檢視時域和頻域的波
形。

您也可以使用Gating (範圍)，僅選
擇頻譜分析的一部份時域波形。
( 請參閱頁83，範圍)

快速秘訣

頻譜算術運算波形的來源須為波道或其他算術運算波形。

使用短記錄長度可提供更快的儀器響應。

使用長記錄長度可降低與訊號相關的雜訊，並提高頻率解析度。

不同的視窗功能會在頻譜中產生不同的濾波器響應波形，而且會產生不同的解析度頻寬。如需更
多資訊，請參閱線上說明。

解析度頻寬 (RBW) 直接控制閘道寬度。因此，當您調整此控制項時，時域閘道標記也會隨著移動。

您可以在頻譜中顯示實際資料或假想資料的線性振幅。這項功能在您離線狀態處理頻譜，並將其
轉換回時域軌跡時特別有用。
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使用波罩測試
序列 通訊波罩測試 (Serial Communications Mask Testing，配合 MTM 或是 MTH 選項)，可用來比較 訊號
和預先定義的範本或波罩。通過此項測試的訊號， 必將座落於波罩定義的區段之外。一般來說， 這
些波罩是由 ANSI 這類標準協會完成定義。如果要執行波罩測試，請執行下列動作：

1. 選取 Masks > Source...(波罩>來
源...)。

2. 選取訊號來源。

3. 按一下Masks (波罩)索引標籤。

4. 選取特定類型和標準類型。
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5. 請按一下Config (組態)來存取Mask
Configuration (波罩組態) 控制視
窗。您可在其中調整波罩和違反
的顯示方式，及 Mask Autoset (波
罩自動設定) 和 Autofit (自動適應)
的組態方式。

6. 按一下 Masks (波罩)，便可返回
Mask Setup (波罩設定) 控制視窗。

7. 按一下 Lock Mask to Wfm (將遮罩
鎖到波形) On (開啟)，便可追蹤水
平或垂直設定的波罩變更。

8. 切換成 Hit Count (計算擊數)On (開
啟)，便可在波罩測試期間反白選
取違反區段。

9. 按一下 Autoset (自動設定)，便可
自動根據輸入訊號特性將波形對
齊波罩。

10. 切換成 Autofit (自動適應) On (開
啟)，便可自動在每次擷取之後重
新設定波形位置，以便盡量減少
命中次數。

11. 按一下 Tolerance (容許度) 索引標
籤，再設定容許度。

大於 0% 的容許度設定值會提高
波罩測試的通過難度。若是小於
0%，則表示測試比較容易通過。

如果您要依照標準指定方式來使
用波罩，請使用 0%。改變這個百
分比例便可進行邊際測試。
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12. 選取 Pass/Fail Setup (通過/失敗設
定)索引標籤，設定通過∕失敗參
數。(如果是使用 WfmDB 擷取模
式，波形數目索引標籤將變成取
樣。)

13. 選取 Pass/Fail Test Notifications (通
過/失敗測試通知)。

14. 選取您要測試的極性。

15. 切換成 Pass/Fail Test (通過/失敗測
試) On (開啟)，便可開始波罩測
試。

16. 切換成 Repeat (重複) On (開啟)，
便可持續執行波罩測試。

17. 選取當測試完成時要發出的通知。

18. 按一下 Pass/Fail Results (通過/失敗
結果)索引標籤可檢視測試結果。

19. 切換成 Pass/Fail Test (通過/失敗測
試) On (開啟)可開始波罩測試。

20. 按一下 Reset (重置) 可重置總數，
並清除所有違反。

快速秘訣

如果訊號沒有在波罩範圍內，請啟用 Autoset (自動設定) 來將波形置入波罩中間。
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使用極限測試
選用性的極限測試可比較作用中訊號與波模波形。使用良好的訊號來建立波模波形並與作用中訊號做
比較，以進行通過/失敗測試。

1. 選取 Masks > Limit Test Setup... (遮
罩 > 極限測試設定...)。

2. 若要建立波模，請選取 Source
(來源)、Destination (目的地) 和
Tolerances (容許度)。可使用多功
能旋鈕來調整容許度。容許度可
指定訊號的允許邊際，超過後極
限測試便失敗。

3. 按一下Save (儲存)。您可以建立
並儲存多個波模供日後使用。

4. 選取來源波形以和波模比較。

5. 選取波模和來源波形做比較 (通
常是您在步驟 3 建立的波模)。

6. 按一下 Failure Notification (失敗通
知)，可設定失敗通知。

7. 選取失敗通知，按一下 Setup (設
定)，回到設定控制視窗。
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8. 按一下 Lock Template to Waveform
(將波模鎖定於波形) 的 On (開
啟)，將波模的垂直刻度或位置鎖
於來源波形的垂直刻度或位置。

9. 按一下Highlight Hits (反白擊數)的
On (開啟)，以不同顏色顯示落於
波模外部的點。

10. 切換到Limit Test (極限測試)的 On
(開啟)，啟動測試。

11. 按一下 Reset (重設)，可清除所有
違反，重設測設。

快速秘訣

您可以使用作用中或已儲存的波形來建立極限測試波模。

使用平均擷取模式，可建立更平緩的波模波形。

使用「包封」擷取模式，可建立允許偶發過激量的波模。
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MyScope

您可以透過 MyScope，建立僅包含一般常用控制項的自訂控制視窗。將個人使用的控制項放入自訂的
控制視窗之後，您就不用在幾個控制視窗之間切換。

本節將介紹建立和使用 MyScope 控制視窗的程序。線上說明將提供詳細資訊。

建立新的 MyScope 控制視窗

1. 選取 MyScope > New Control Win-
dow...(MyScope>新增控制視窗...)。

2. 按一下 + 來展開類別。每個類別
都會包含可新增到 MyScope 控制
視窗的控制項。這些類別對應功
能表列，以協助您找到通常使用
的控制項。
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3. 按一下控制項來預覽。

4. 按兩下控制項，或是按一下 + 來
展開控制項清單。(如果這時沒有
顯示 +，表示該控制項目無法更進
一步自訂。)
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5. 清除核取方塊，移除任何您不希
望包含在該控制項中的元件。

6. 按一下控制項，並將它拖曳到
MyScope 控制視窗。當您釋放滑
鼠時，該控制項就會嵌入最靠近
的方格位置。您可以按一下並拖
曳該控制項，便可在 MyScope 控
制視窗中改變控制項的位置。
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7. 按一下 New Tab (新增索引標籤)
以在 MyScope 控制視窗中新增索
引標籤。您最多可有 六個索引標
籤。

8. 如果要重新命名索引標籤，請執
行下列動作之一：

按一下Rename Tab (重新命名索
引標籤)

按兩下索引標籤，再輸入新名
稱。

9. 按一下User Pref...(使用者偏好...)，
指定要載入MyScope控制視窗的使
用者偏好。

10. 如果要刪除控制項，請執行下列
動作之一：

選取索引標籤，再按一下Delete
( 刪除)。這樣就可刪除索引標
籤和其中所有的控制項。

選取控制項，再按一下 Delete
( 刪除)。如此只會刪除選取的
控制項。

11. 按一下 Save (儲存)，然後輸入
MyScope 控制視窗的名稱，或是
使用預設名稱。

快速秘訣

如果要重新設定控制項，請按一下該項，並將其拖回到預覽視窗。接著選取或清除核取方塊，以
便包括或移除控制項中的元件。

如果要改變索引標籤的順序，請按一下索引標籤，再將它拖曳到新位置。

如果要刪除控制項，請按一下該項， 再將它拖曳到螢幕的上半部 (拉離 MyScope 控制視窗)。
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使用 MyScope 控制視窗
如果要開啟先前所定義的 MyScope 控制視窗，請執行下列動作：

1. 選取 MyScope > Open Control Win-
dow...(MyScope>開啟控制視窗...)，
或選取5個最常使用的MyScope視
窗之一。

2. 選取您要使用的 MyScope 控制視
窗，並按一下 Open (開啟)。

如果要顯示作用中的 MyScope 控制視窗，請執行下列動作：

1. 選取MyScope > Current...(MyScope>
目前...)，或於工具列模式中按一
下 MyScope。(即使 MyScope 控制
視窗並未顯示，它還是有在持續
作用。)

如果要編輯 MyScope 控制視窗，請執行下列動作：
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1. 選取 MyScope > Edit Control Win-
dow...(MyScope>編輯控制視窗...)。

2. 選取您要編輯的控制視窗，並按
一下 Open (開啟)。

快速秘訣

有些控制項在 MyScope 控制視窗中，會執行與它在標準控制視窗中的不同功能。如需詳細資訊，
請參閱線上說明。

您可以將 MyScope 控制視窗 (.tcw 檔案) 複製到其他 DPO7000 和 DPO/DSA70000/B 系列儀器。
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儲存和叫出資訊

本節將介紹從您的儀器儲存和叫出螢幕捕捉及設定、儲存測量值、使用剪貼簿和列印等程序。線上說
明將提供詳細資訊。

儲存螢幕捕捉

1. 選取 File > Save (檔案>儲存)，或
是 Save As > Screen Capture...(另存
新檔>螢幕捕捉...)。

2. 如果您要設定 Palette (調色盤)、
View (檢視)、Image (影像)或 Screen
Capture Format (螢幕捕捉格式)等選
項，請按一下 Options...( 選項...)；
否則請跳至步驟 3。
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3. 選取要儲存該螢幕捕捉的位置。

4. 輸入螢幕捕捉的名稱，或是使用
預設名稱，接著選取檔案類型。

5. 按一下 Save (儲存)。

快速秘訣

如果要快速儲存多個螢幕捕捉，請選取 Set Front Panel Print Button to Save (設定前面板列印按鈕成儲
存)，再按一下 Save (儲存)。這樣一來，您只要按下前面板的 Print (列印) 按鈕，就可以儲存螢幕捕
捉。

儲存波形

1. 如果要儲存波形，請選取 File >
Save (檔案>儲存)，或是 Save As >
Waveform...(另存新檔>波形...)。
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2. 按一下 Waveform (波形)。

3. 如果您要指定Waveform Data Range
(波形資料範圍)、FastFrame Data
Range (快速圖框資料範圍)、Wave-
form Detail (波形細節)、Data Desti-
nation (資料目的地)、Source (來源)
或是 Data Ordering (資料順序)，請
按一下 Options...(選項...)；否則請
跳至步驟 4。

4. 選取 Source (來源)。

5. 您可以將波形另存成儀器記憶體的
參考波形，或是另存成Windows目
錄中的 .wfm 檔案。如果要將波形
另存成參考波形，請選取Ref 1–4
(參考 1–4)。如果要另存成 .wfm
檔案，請選取您要儲存該波形的
位置。

6. 如果您要將波形儲存成 .wfm 檔
案，請輸入檔案名稱，或是使用
預設名稱。

7. 按一下 Save (儲存)。

快速秘訣

選取 Auto-increment file name (自動遞增) 檔名可直接儲存大量的相似波形，而不需要每次都重新輸
入完整檔名。

如果要快速儲存多個波形，請選取 Set Front Panel Print Button to Save (設定前面板列印按鈕成儲存)，
再按一下 Save (儲存)。這樣一來，您只需按下前面板的 Print (列印) 按鈕即可儲存波形。
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叫出波形

1. 選取 File > Recall...(檔案>叫出...)。

2. 按一下 Waveform (波形)。

3. 選取您要叫出波形的 Destination
( 目的地)。

4. 選取要叫出的波形。

5. 按一下Recall (叫出)。按一下Recall
(叫出) 便可開啟參考波形，並啟
動 Reference Waveform (參考波形)
控制視窗。

6. 使用控制項來調整參考波形。您也
可以選取 File > Reference Waveform
Controls...(檔案>參考波形控制...)
來存取Reference Waveform (參考波
形) 控制視窗。

快速秘訣

您可以儲存多種不同的檔案類型，但是您只可以叫出設定 (*.set) 檔案和波形 (*.wfm) 檔案。
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儲存儀器設定

1. 選取 File > Save (檔案>儲存)，
或 Save As > Setup...(另存新檔>設
定...)。

2. 按一下 Setup (設定)。

3. 選取要儲存該設定的位置。您可
以將設定儲存到儀器記憶體提供
的十個設定儲存位置其中之一，
或是另存成 Windows 目錄中的 .set
檔案。

4. 輸入檔案名稱或是使用預設名稱。
使用跳出鍵盤輸入要存到儀器記
憶體中的設定檔案名稱。

5. 按一下 Save (儲存)。

快速秘訣

如果有啟用觸控顯示螢幕，請使用跳出數字鍵盤為設定加上便於識別的標籤。

使用 Auto-increment (自動遞增) 檔名可直接儲存大量的相似檔案，而不需要每次都重新輸入完整檔
名。

如果要快速儲存多個設定，請選取 Set Front Panel Print Button to Save (設定前面板列印按鈕成儲存)，
再按一下 Save (儲存)。這樣一來，您只需按下前面板的 Print (列印) 按鈕即可儲存設定。
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叫出儀器設定

1. 選取 File > Recall...(檔案>叫出...)。

2. 按一下 Setup (設定)。

3. 選取您要叫出的設定檔案。您可
以從儀器記憶體十個位置其中之
中或是從 Windows 目錄，叫出所
需的設定檔案。

若您要保留目前的偏移校正設定，
按一下 Don’t recall deskew values (
不叫出偏移校正值)。

4. 按一下 Recall (叫出)。

快速秘訣

您可以叫出儲存在磁碟上的任何設定，然後將其存到內部設定儲存位置以便更快速存取。
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儲存測量值

1. 選取 File > Save (檔案>儲存)，或
Save As > Measurement...(另存新檔>
測量...)。

2. 如果您要指定 Displayed Measure-
ments (已顯示的測量值)、Measure-
ment Snapshot (測量值快照集) 或
Measurement Format (測量值格式)，
請按一下 Options... (選項...)；否則
請跳至步驟 3。
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3. 選取要儲存該測量的位置。

4. 輸入該測量的名稱，或使用預設
名稱，然後選取檔案類型。

5. 按一下 Save (儲存)。

複製結果到剪貼簿
使用下列程序，設定要複製到 Microsoft 剪貼簿之影像、波形或測量值的輸出內容和格式。

1. 選取Edit > Copy Setup...(編輯>複製
設定...)。
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2. 按一下 Images (影像)、Waveforms
(波形) 或 Measurements (測量值) 索
引標籤，然後選取所需選項。

如果要複製影像、波形或是測量值，請使用下列程序：

1. 選擇您要複製的項目。

2. 選取 Edit > Copy (編輯>複製)，或
是按下 Ctrl + C。

3. 按下 Ctrl + V，便可將該項目貼入
Windows 應用程式。
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列印輸出

1. 如果要列印輸出，請執行下列動
作之一：

按下 PRINT (列印)。

選取 File > Print (檔案>列印)。
如有必要，您可以在Page Setup
( 版面設定)對話方塊中更改版
面配置。

列印 (Print) 和 Page Setup (版面設定)
對話方塊依所使用印表機而有差異。

2. 按一下 Page Setup... (版面設定...)。
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3. 選擇列印參數。
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執行應用軟體

選項 Application Software CD (選配應用軟體 CD) 包含了供您安裝在儀器上，免費使用 5 次的選配應用軟
體。這些應用程式會提供特定應用程式的測量解決方案。下面將介紹一些使用範例。同時也提供其他
套件。如需詳細資訊，請聯絡 Tektronix 代理商或造訪我們的網站 www.tektronix.com。

使用 ASM Advanced Event Search and Mark (進階事件搜尋和標記)，反白重要事件並略過不重要的事
件以進行資料檢查。

使用 CP2，可以執行波罩和測量相容性測試，檢驗是否符合 ITU-T G.703 和 ANSI T1.102 通訊標準。

使用 DDRA Memory Bus Analysis (記憶體匯流排分析)，以自動辨識 DDR1、LP-DDR1、DDR2、DDR3
和 GDDR3 讀取和寫入。

使用 DSPT Display Port Compliance Software (顯示埠相容性軟體)，以確認 IC、主機板和顯示卡的設
計。

使用 DVI Compliance Test Solution Software (相容性測試解決方案軟體) 進行 DVI 實體層相容性測試。

使用 ET3，可以執行 10/100/1000 Base-T Ethernet 相容性測試。

使用 FBD RTE 模組，可分析 ≥4 GHz 型號的 FB-DIMM 相容性。

使用 HT3 HDMI Compliance Test Software (相容性測試軟體)，可進行 HDMI 相容性測試。

使用 IBA RTE 模組，可分析 ≥4 GHz 型號的 InfiniBand。

使用 J2 Disk Drive Measurement Software (磁碟機測量軟體)，可以依據 IDEMA標準來測量磁碟機訊號。

使用 JA3 Advanced 或 JE3 Essentials Jitter Analysis Software (抖動分析軟體)，可以辨識時序效能特徵。
使用單擊訊號擷取，可以分析鄰接時脈週期的抖動。

使用 LSA Serial Analysis Software (串列分析軟體) 可進行 CAN/LIN 通訊協定觸發和分析。

使用 LT Waveform Limit Testing (波形極限測試)，以比較擷取的波形以及您設定的容許度界限。

使用 MTH Communication Mask Testing Software (通訊波罩測試軟體)，可進行 ≥4 GHz 型號的波罩相容
性測試。

使用 MTM Communication Mask Testing Software (波罩測試軟體)，可進行 <4 GHz 型號的 波罩相容性
測試。

使用 RTE Real Time Eye Measurement Software (即時眼狀圖測量軟體)，可執行串列相容性和分析。其
中 提供多種串列標準的相容性模組。

使用 PCE RTE 模組，可分析 ≥4 GHz 型號的 PCI-Express。

使用 PTH、PTU 或 STU Serial Protocol Trigger Software (串列通訊協定觸發軟體)，可觸發與解碼高速
串列或資料通訊協定的 8 B/10 B 資料。 通訊協定觸發至 5 GS/s。

使用 PTM 和 PTD Serial Protocol Trigger and Decode Software (串列通訊協定觸發和解碼軟體) 簡化驗證
程序，並隔離資料速率達到 1.25 Gb/s 的資料相關錯誤。

使用 PWR Power Measurement Software (功率測量軟體)，可以快速測量並分析電源供應開關裝置和磁
性元件的功率消耗。

使用 SLA 和 SLE Serial Data Link Analysis (串列資料連結分析)，以分析串列資料連結。

搭配選配 RTE，使用 SST Serial ATA 和 Serial Attached SCSI 相容性模組。

使用 USB 可以辨識 USB2.0 訊號特徵，包括波罩測試和參數測試 (僅 S/W 適用)。
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執行應用軟體

使用 UWB 和 UWBE Ultra-Wideband Spectral Analysis (超寬頻頻譜分析)，快速進行 WiMedia 分析。

使用 VNM CAN/LIN Protocol Analysis Software (通訊協定分析軟體)，可進行 CAN 和 LIN 測試 (不包含
CAN 觸發)。

請依照應用軟體隨附的指示說明進
行安裝。如果要執行軟體，請選取
Analyze (分析)，然後選取應用程式。
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應用範例

應用範例

本節將介紹本儀器在一般故障排除工作中的使用方式，及其擴充使用方式。

捕捉間歇性異常
設計工程師經常面對的一大難題，就是找出間歇性故障的發生原因。如果您知道自己要尋找哪種異常
狀況，您就可以輕鬆地設定示波器進階觸發功能，隔離找出該異常狀況。然而，當您不知道自己要尋
找哪種異常狀況時，整個過程就會顯得十分冗長而耗時。尤其在使用傳統數位儲存示波器只能提供極
慢波形擷取速率時，更是如此。

加入 DPX 技術之數位螢光示波器所特別提供的 FastAcq 快速擷取模式，可讓您在數秒鐘或數分鐘之內
找出這類異常狀況。一般的 DSO 通常要花上好幾個小時、甚至幾天，才能找出此類異常事件。

使用下列程序來捕捉間歇性異常狀況。

1. 將探棒連接到輸入訊號源。

<4 GHz 的型號

≥4 GHz 的型號
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應用範例

2. 按下 Autoset (自動設定)。

3. 選擇 Display > Display Persistence >
Infinite Persistence (顯示> 持續顯示
> 無限餘輝)。此例中，您 將查看
時脈訊號。在觀察訊號 1–2 分鐘
之後， 以及從其他位置尋找問題
之前，請先移至步驟 4。

4. 按下 FastAcq (快速擷取)。
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應用範例

5. 尋找出現在訊號中的突波、暫態
訊號或其他隨機異常。此例中，
FastAcq 僅在執行幾秒鐘之後就找
到 300 ns 的正突波。

6. 如果要觸發在步驟 5找到的突波，
請選取Glitch Setup...(突波設定...)。

7. 選取適當的極性。

8. 按一下 Level (位準)，再依照您在
步驟 5 找到的突波設定位準。

9. 按一下 Width (寬度)，再依照您在
步驟 5 找到的突波設定寬度。
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應用範例

10. 按一下 E-mail on Trigger (依觸發傳
送電子郵件) On (開啟)。 ( 請參閱
頁129，設定「依事件發出電子郵
件」)

11. 按下 Single (單一擷取)可觸發單一
突波。

使用延伸式桌面和有效記錄的 OpenChoice 架構
工程師經常需要記錄自己的實驗工作，以供日後參考。您可能不想要將螢幕參數一次顯示和波形資料
先儲存到 CD 或 USB 記憶體裝置，以後再產生報告；這時您可以嘗試使用 OpenChoice 架構，即時記錄
您的工作。

如果要將儀器加入到設計和文件撰寫程序，請使用下列程序。

1. 將 Microsoft Word 或 Excel 載入本
儀器。

2. 連接第二台監視器。(請參閱頁9，
新增第二台顯示器)
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應用範例

3. 開啟Microsoft Word，再將Word視
窗拖曳到延伸的桌面。

4. 按一下 TekScope 便可恢復到儀器
應用程式。

5. 選取 Edit > Select for Copy > Full
Screen (bitmap) [(編輯>選取以複製
>全螢幕 (點陣圖))]。

6. 按下 Ctrl+C。

7. 在您要放置螢幕參數一次顯示的
Word 文件位置中按一下滑鼠，再
按下 Ctrl+V。

快速秘訣

本儀器隨附多種專門設計的 OpenChoice 軟體工具，可確保提供最大效能以及與其餘設計環境的連
接性。
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在匯流排上觸發
您可以使用您的儀器在 CAN (選配)、 I2C 和 SPI 匯流排上觸發。這台儀器可以顯示 實體層 (就像類比
波形)，以及在 CAN 和 LIN 觸發時顯示的通訊協定 層級資訊 (就像數位和符號波形)。

注意。 有些觸發方式選項不適用於某些儀器。

若要設定匯流排觸發：

1. 選取 Trig > A Event (Main) Trigger
Setup...(觸發> A 事件 (主要) 觸發
設定...)。

2. 在 A Event (A 事件) 索引標籤中設
定 A 觸發方式和來源。

3. 選取 Trigger On (觸發開啟) 以選擇
想要的觸發功能。

4. 根據您選擇的 Trigger On (觸發開
啟)選項，您可能還需要選擇其他
選項。
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在視頻訊號上觸發
本儀器支援觸發 NTSC、SECAM、PAL 和高解析度訊號。

如果要在視頻圖場上觸發：

注意。 這種視頻觸發方式不適用於某些儀器。

1. 選取 Trig > A Event (Main) Trigger
Setup...(觸發> A事件(主要)觸發設
定...)。

2. 在 A Event (A 事件) 索引標籤中設
定 A 觸發方式和來源。

選取 Format > 525/NTSC (格式>
525/NTSC)。

3. 選取 Trigger On > Field (觸發開啟 >
圖場)。

選取Odd (奇數)、Even (偶數)或All
(全部)圖場。
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在排線上觸發

若要觀察圖場中的視頻線：

1. 選取 Trig > A Event (Main) Trigger
Setup...(觸發> A事件(主要)觸發設
定...)。

2. 在 A Event (A 事件) 索引標籤中設
定 A 觸發方式和來源。

選取 Format > 525/NTSC (格式 >
525/NTSC).

3. 選取 Trigger On > All Lines (觸發開
啟 >全部排線)。
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設定「依事件發出電子郵件」

1. 選取 Utilities > E-mail on Event >
Setup...(公用程式 > 依事件發出電
子郵件 > 設定...)。

2. 輸入收件人的電子郵件地址。使
用逗號分隔多個地址項目。電子
郵件地址方塊的長度限制是252個
字元。

3. 按一下 Config (組態)，然後輸入
SMTP伺服器位址。請聯絡網路管
理員取得正確位址。
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4. 選取當發生時要發送電子郵件的
事件。

5. 如果要包含附件，請選取附件類
型，再選取Settings (設定)來指定
格式。

6. 設定最大訊息限制和電子郵件大
小。如果已到達最大訊息限制，
您必須按一下 Reset (重置)，才能
再依事件發出電子郵件。

7. 若要確定您設定的電子郵件地址
無誤，請按一下 Send (傳送)來傳
送測試郵件。

8. 如有需要，請按一下Config (組態)
來存取電子郵件組態對話方塊，
並調整其組態。

快速秘訣

如果要將附件儲存到儀器硬碟中，請將最大訊息大小設成零 (0)。這樣附件就會根據其類型，儲存
到預設位置 C:\TekScope\Screen Captures、Waveforms 或 Data 等位置。

無法輸入有效的收件人電子郵件地址， 或是 SMTP 伺服器位址顯示錯誤訊息。
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建立 Tektronix 示波器和邏輯分析儀之間的資料關聯
幾乎每一項設計都是包括高速時脈邊緣和資料速率的高速設計。針對這些設計，您必須觀察高速數位
訊號與電路中複雜數位事件之間相關的類比特徵。iView 就是用來連接數位世界和類比世界的窗口。
iView 功能可以流暢地為 Tektronix 邏輯分析儀和示波器自動依據時序關聯資料，讓您只要按一下滑鼠，
就可以將示波器的類比波形傳輸到邏輯分析儀顯示畫面。同步檢視時序關聯的類比和數位訊號，並在
極短時間指出捉摸不定的突波和其他問題的來源。

您可利用 iView 外部示波器電纜線，將邏輯分析儀連接到 Tektronix 示波器，建立這二部儀器之通訊。
您可以從 TLA 應用系統功能表啟動「外部示波器」精靈，依照其步驟執行，完成連接邏輯分析儀和
示波器 iView 電纜線的整個程序。

也提供設定視窗，協助您確認、變更和測試示波器設定。擷取和顯示波形之前，須先使用「外部示波
器」精靈建立好 Tektronix 邏輯分析儀和示波器的連線。

1. 從邏輯分析儀的系統功能表，選
取Add iView External Oscilloscope...
(新增 iView 外部示波器...)。

2. 選取示波器型號。

3. 依照螢幕指示，然後按一下Next (
下一步)。

4. 如需更多邏輯分析儀與示波器關聯
資料的詳細資訊，請參閱Tektronix
邏輯分析儀的說明文件。
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使用極限測試來驗證效能
生產線測試工程師經常需要使用已知的良好參考產品來比較生產線產出產品的效能。如果測試中裝
置 (Device under test，DUT) 的訊號都在使用者定義的參考產品容許度內，即裝置通過測試。請使用下
列程序使用您的儀器進行這類測試.

1. 在參考產品上擷取所需要的訊號。

<4 GHz 的型號

2. 選取 Limit Test Setup... (極限測試
設定...)。
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3. 從 Source (來源) 清單選取已知的
良好參考波形的波道。

4. 從 Destination (目的地)清單選取波
模的儲存位置。

5. 輸入垂直和水平容許度，以指定
容許 DUT 偏離波模的程度。

6. 按一下Save (儲存)。您建立完成的
波模是內建指定容許度的已知良
好參考的快照。請注意，按一下
Save (儲存) 後會自動啟動波模。

7. 將探棒從參考產品移至 DUT。

≥4 GHz 的型號：

8. 選取連接至 DUT 的來源波道。

9. 選取您在步驟 4 儲存的波模。

10. 按一下 Failure Notification (失敗通
知)，可設定失敗通知。

11. 在此例中，請按一下 Stop Acq (停
止擷取) 的 On (開啟)，再按一下
Setup (設定)，回到設定控制視窗。
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12. 按一下 Lock Template to Waveform
(將波模鎖定於波形) 的 On (開啟)
和 Highlight Hits (反白擊數) 的 On
(開啟)。

13. 切換到 Limit Test (極限測試)的 On
(開啟)，啟動測試。

儀器拿波模與每個擷取的波形做比較，直到有與波形不符合的波模出現。有波形與波模不符時便停止
擷取，並以不同的顏色顯示違反。下列範例在上方顯示 Ch 1，方便您查看 Ch 1、波模和擊數。
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清潔
使用這些程序來清潔您的儀器。如果需要其他清潔，請交由合格的人員處理。

清潔外部

使用不沾絨質的乾布或軟毛刷，清潔底盤外面。如果還有灰塵，可用沾上濃度 75% 的異丙醇溶劑的布
或紗布。控制及接頭周圍的狹窄處，可用紗布清潔。不可使用有磨蝕性的清潔劑清潔底盤。

使用濕的清潔布來清潔 On/Standby (開啟/待機) 開關。不可以直接弄濕開關。

小心。 不當的清潔劑、方法或施力會損傷儀器。請勿使用可能損傷示波器塑膠部分的化學清潔劑。
只可用去離子水來清潔前面板按鈕。使用濃度 75% 的異丙醇溶劑當做清潔劑，並以去離子水清洗。若
要使用其他類型的清潔劑，請先洽詢 Tektronix 服務中心或服務人員。

清潔外部時為防止弄濕儀器內部，只能以適量液體沾濕布或塗抺器。
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索引

索引

ENGLISH TERMS
ARM 狀態燈, 50
Autoset Undo (復原自動設

定), 27
CAN, 126
CAN 觸發

已定義, 50
Display Remote (遠端顯示), 8
FastAcq/WfmDB 調色盤, 62
I2C, 126
iView, 131
Linear (線性) 內插法, 59
MultiScope 觸發, 42
MultiView Zoom, 64
MyScope

使用, 105
新增控制視窗, 101
編輯, 105

OpenChoice
範例, 124

Pinpoint 觸發, 46
Pinpoint 觸發選項, 49
READY 狀態燈, 50
RS-232 觸發

已定義, 50
Screen (螢幕) 游標, 87
Sin(x)/x 內插法, 59
SPI, 126
SPI 觸發

已定義, 49
TekLink, 42
TRIG’D 狀態燈, 50
Undo Last Autoset (復原上一次

自動設定), 27
V Bars (垂直線條) 游標, 87
X-Y 顯示格式, 58
X-Y-Z 顯示格式, 58
Y-T 顯示格式, 58

一
一般觸發模式, 46
一般調色盤, 62

丨
串列, 126

丶
主要觸發, 47, 51

人
介面圖, 16
使用者偏好, 27
使用者定義調色盤, 63
使用者標記, 70
依事件發出電子郵件

設定, 129
依觸發傳送電子郵件, 54
停止擷取, 32
側面板圖, 14
儀器設定

儲存, 111
叫出, 112

儲存
波形, 108
測量值, 113
螢幕捕捉, 107
設定, 111
電子郵件附件, 130

入
內插法, 29, 59
內部 IC 控制項觸發

已定義, 49
全螢幕方格圖樣式, 61

八
其他測量值, 81

刀
列印, 116
前置觸發, 46, 47
前面板圖, 13

力
功能表, 20
加強 DSP 頻寬, 35
加強型頻寬, 35

勹
包封擷取模式, 30

匚
匯出 請參閱 儲存
匯流排, 126

十
十字線方格圖樣式, 61

厶
參考位準, 86
參考色彩, 63

又
取樣

內插即時, 28
即時, 28
等時, 29

取樣擷取模式, 30
取樣過程

已定義, 28

口
叫出

波形, 110
設定, 112

可變餘輝, 57
向量

波形顯示方式, 56
單次程序, 32
單色灰色調色盤, 63
單色綠色調色盤, 62

囗
圖框方格圖樣式, 61

土
垂直位置, 26
垂直位置和自動設定, 27
增亮樣值

波形顯示方式, 56
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夕
多塊縮放區域, 66

女
如何執行

搜尋整個波形並新增標
記, 70

宀
安全摘要, v
寬度觸發

已定義, 49

山
峰值檢測擷取模式, 30

干
平均擷取模式, 30

广
序列波罩測試, 96

廴
延伸式桌面, 9, 124
延遲觸發, 47, 51

弓
強制觸發, 46

彳
後置觸發, 46, 47
後面板圖, 14

心
快照, 84
快速圖框, 38

圖框搜尋工具, 41
快速擷取, 34, 121
應用軟體, 118

手
按滑鼠右鍵的功能表, 20
按鈕

設定 / 清除標記, 71
振幅測量值, 80

捲動模式, 37
捲動模式互動, 38
捲動縮放波形, 67, 69
捷徑功能表, 20
探棒

偏移校正, 28
校準, 28
補償, 28

控制面板, 13
控制面板圖, 18
搜尋, 70, 72
操作規格, 2
擷取

取樣, 28
輸入波道和數位器, 28

擷取模式
已定義, 30
改變, 31

斤
新增濾波功能

使用者可定義, 92

方
方格圖方格圖樣式, 61
方格圖樣式, 61

日
日期和時間, 62
時序註記, 40

已定義, 38
時間測量值, 80

木
校準, 23
極限測試, 99

範例, 132
標籤, 59
標記, 70, 72
模式觸發

已定義, 49
樣式鎖定觸發, 49

欠
次序觸發, 51

水
水平位置

已定義, 26
相加 (and) 算術運算波

形, 93
水平刻度

相加 (and) 算術運算波
形, 93

水平延遲, 55
水平標記, 66
水平線條游標, 87
波形

使用者標記, 70
儲存, 108
叫出, 110
搜尋和標記, 70
游標, 87
顯示樣式, 56

波形記錄
已定義, 29

波形資料庫擷取模式, 30
波罩

自動設定, 97, 98
自動適應, 97
通過∕失敗測試, 98
邊際容許度, 97

波罩測試, 96
清潔, 135
清潔外部, 135
測量值, 78

儲存, 113
參考位準, 86
已定義, 80
快照, 84
游標, 86
精確度, 28
統計, 83
自訂, 82
註解, 84

游標測量值, 86
溫階調色盤, 62

火
無限餘輝, 57

片
片段記憶體, 38

138 DPO7000 系列和 DPO/DSA70000/B 系列快速入門使用者手冊



索引

牛
物件

顯示, 61, 62

犬
狀態觸發

已定義, 49

目
直接列印, 116
相關說明文件, xiii

矢
矮波觸發

已定義, 49

穴
突波

擷取, 30, 34, 121
觸發 開啟, 47

突波觸發
已定義, 49

竹
算術運算

任意濾波器, 92
波形, 90
編輯器, 91
色彩, 64

範圍, 83

糸
統計, 83
網路連線, 8
線上說明, 19
縮放, 64
縮放方格圖尺寸, 65

耒
耦合

觸發, 47

自
自動捲動, 67, 69
自動觸發模式, 46
自動設定, 27

虫
螢幕參數一次顯示

儲存, 107
螢幕文字, 59

衣
複製, 114

見
規格

操作, 2
電源供應, 5

視窗觸發
已定義, 49

視頻
排線, 128

視頻觸發, 127
已定義, 49

角
觸發

MultiScope 觸發, 42
串列, 126
位準, 47
前置觸發, 46, 47
延滯, 46
強制, 46
後置觸發, 46, 47
斜率, 47
概念, 46
模式, 46
狀態, 50
耦合, 47
讀值, 50

觸發事件
已定義, 46

觸發位準標記, 61
觸發位置, 53
觸發方式

已定義, 49

言
記錄檢視調色盤, 62
設定 / 清除標記按鈕, 71
設定∕保持觸發

已定義, 49
診斷, 21
說明, 19
說明文件, xiii

調色盤, 62
讀值

觸發, 50

車
軟體

選配, 118
輸入檢查, 21
輸入訊號, 25
轉態觸發

已定義, 49

辵
通訊

測量值, 82
觸發, 已定義, 49

逾時觸發
已定義, 49

遠端顯示, 8
選擇觸發類型, 48
邊緣觸發

已定義, 49
邏輯分析儀

關聯資料, 131

酉
配件, 1

里
重疊圖框, 40

金
鎖定縮放波形, 67, 69

長
長條圖測量值, 81
長條圖設定, 89

門
開始擷取, 32
開機, 5
閘道寬度和解析度頻寬, 95
關閉電源, 7

阜
隨機雜訊, 30
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隹
雙顯示器, 9

雨
電源供應器, 5

頁
預先定義的算術運算式, 90
預先定義的頻譜算術運算

式, 93

預設值設定, 26
頻寬限制, 37
頻譜分析, 93
頻譜層次調色盤, 62
頻譜算術運算式

進階, 94
顯示

持續, 57
樣式, 56
物件, 61, 62
色彩, 63

顯示圖, 16

食
餘輝

顯示, 57

高
高解析度擷取模式, 30

黑
點

波形記錄點顯示方式, 56
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